
Microsoft® Office 97, Professional Edition
An all new Office 97 integrates intelligent applications with the power of the Web. Easily insert 
hyperlinks between Office documents or out to the Internet. Save your documents as HTML and 
you have an instant Web page. Office 97, Professional Edition includes: Microsoft Excel 97, Word 
97, PowerPoint 97, Outlook 97, Access 97, and Microsoft Bookshelf Basics for quick reference to 
the tools you need most. Standard Edition does not include Access 97 or Bookshelf Basics.
Windows 95 ; earlier version available for Windows 3.1, MacOS
Estimated Academic Price: $199.00, Professional Edition; $159.00, Standard Edition
www.micr osoft.com/office/

Microsoft® Access 97
Get relational database power for everyone, from the novice to the expert user. Get started with the
Database Wizard and create one of over 20 fully functional database applications. The new Publish
to the Web Wizard makes it easy to publish database information to the Web dynamically.
Windows 95 ; earlier version available for Windows 3.1
Estimated Academic Price: $109.00.
www.micr osoft.com/access/

Microsoft® Excel 97
With over 30 million users, Microsoft Excel has grown to be the world’s most popular spreadsheet.
Microsoft Excel 97 streamlines and simplifies core spreadsheet tools to make them more 
accessible to students and teachers and makes it easy to collaborate and share data across 
networks or the World Wide Web.
Windows 95 ; earlier version also available for Windows 3.1 and MacOS
Estimated Academic Price: $109.00.
www.micr osoft.com/e xcel/

Microsoft® Word 97
Microsoft Word 97 gives you everything you need to create professional-looking documents, 
communicate your ideas, and share information on the printed page or across intranets and 
the Internet. The innovative new tools in Word 97 make it easy to get powerful results fast and
unleash the power of your words!
Windows 95 ; earlier version available for Windows 3.1, MacOS
Estimated Academic Price: $84.95.
www.micr osoft.com/w ord/

Microsoft® Works 95
Microsoft Works 95 provides a complete, integrated solution for the classroom, including a word
processor, database, spreadsheet, communications and drawing tools. In and Out of the
Classroom with Works 95, a step-by-step teacher activity guide, is included inside the academic
product box.
Windows 95 ; earlier version available for Windows 3.1, MacOS
Estimated Academic Price: $54.95.
www.micr osoft.com/w orks/

Microsoft® FrontPage™ 97
Microsoft FrontPage makes creating professional-quality Web sites effortless with powerful new
functionality, support for the latest Web technologies, and great integration with Microsoft Office. It’s
never been easier to develop and maintain your own professional Web sites!
Windows 95 ; earlier version available for MacOS
Estimated Academic Price: $69.95.
www.micr osoft.com/fr ontpa ge/

Microsoft® Publisher 97
Create effective, high-impact publications and World Wide Web sites with Publisher 97. It’s perfect
for all your classroom and home projects. In just minutes, you and your students can turn ideas into
professional-looking publications, in print and online. In and Out of the Classroom with Publisher
97, a step-by-step teacher activity guide, is included inside the academic product box.
Windows 95 ; earlier version available for Windows 3.1
Estimated Academic Price: $59.95.
www.micr osoft.com/pub lisher/

Microsoft® Greetings Workshop
Create Hallmark-quality cards, invitations, calendars, banners and more. New projects include
oversized posters, vertical banners, stationery, and stickers. Choose from more than 2,000
Hallmark Connections, or add your own messages and photos.
Windows 95
Estimated Price: $29.95. Academic version includes teacher activity guide.
//Greetings workshop.msn.com
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From the Editor of ELECTRONIC LEARNING

Dear Technology Leader:

What’s the biggest challenge you face in your job as technology leader for your school

or district? Chances are, it’s helping teachers integrate applications software into their

day-to-day teaching.

Now, thanks to Microsoft, that job has just gotten easier.

This special supplement to Electronic Learning is jam-packed with ideas for integrating

computer applications into the intermediate, middle school, or high school classroom.

You’ll find 16 curriculum-based lesson plans with step-by-step instructions for using a

variety of applications software from Microsoft including Microsoft® Office 97,

Professional Edition (Microsoft® Excel, Word, PowerPoint and Access, Microsoft® Publisher

97, Greetings Workshop and Microsoft® Works 95.) With these Office 97 applications, 

the new Office Assistant provides help on demand to guide teachers and students in

making the most of these lessons. Be sure to give it a try! 

And, for more detailed step-by-step instructions as well as some additional lesson 

ideas, check out the following Web site:  

www.microsoft.com/education/curric/activity/

Developed by the editors of Electronic Learning in partnership with Microsoft, this

book is designed to be used in two ways:

1.  As a resource for your Professional Development workshops.

The lessons make learning about applications software relevant

and timely for any teacher.

2.  As a resource for classroom teachers. Each lesson includes a

Teacher Guide plus a reproducible activity that students can use

individually or with other students. 

We think you’ll find that the lessons in this book can help everyone—from the 

computer novice to the most experienced user—explore the enhanced teaching and 

learning opportunities that exist with applications software...and help make one of 

your most challenging jobs just a little easier.

Sincerely,

Mickey Revenaugh

Editor, Electronic Learning Magazine

P. S. More teacher activity guides for Microsoft products are available online at: 

www.microsoft.com/education/resource/default.htm 
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INTERMEDIATE/
MIDDLE SCHOOL

In a hands-on environmental science

project, students learn about recy-

cling as they collect data on their

own family’s trash production, ana-

lyze the data with worksheets, chart

the data, and present their findings.

◆ To have students learn how to 

calculate simple worksheet formulas 

◆ To collect and chart data from

real-world settings 

◆ To shape data into meaningful

statements within a broader social

context.

◆ Knows how to create a

Microsoft® Excel worksheet and

use functions

◆ Can create a slide presentation

using Microsoft® PowerPoint® 

Approximately six weeks to

three months

Ask students how much they

know about protecting the Earth’s

environment. We all know, for

example, that pollution threatens

resources. But do they know

which resources? (The ocean,

fresh water, air, etc.) How can

over-use also threaten resources? 

(For example, extensive land

development or over-timbering

can threaten trees, soil, wildlife,

and plant life.) In what way does

household trash contribute to the

problem? (In two ways: Overuse

of resources, such as trees/paper;

pollution from too much trash,

which creates too much landfill;

too many “non-biodegradable”

products.) 

Next, discuss recycling with

your class. Why is recycling

important and helpful for the

future? Ask students to take a

guess on  how many pounds of

trash they personally produce

every year and have them share

their guesses with the class. Tell

students that in this activity

they will find out how much

trash they and their families

actually produce during a year,

how much is recycled, and how

much more might be recycled.

Explain that in the “Don’t Trash

the Earth” project, students will

weigh and, if possible, separate

family trash into waste and

recyclables, chart the results

for three weeks, and analyze the

data. 

Send each student home with

a copy of the reproducible at

the end of this lesson, which

explains the “Don’t Trash the

Earth” project to parents. Sign

the bottom of the handouts,

and ask each student to write

his/her name in the blanks. 

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

Teacher Guide

U.S. TRASH PRODUCTION 
1960-1990

YEAR WASTE POPULATION
(million tons/year)        (millions)

1960 87 179

1965 104 190

1970 121 203

1975 136 214

1980 150 227

1985 166 238

1990 182 249

REQUIRED SOFTWARE

◆  MICROSOFT EXCEL 97

◆  MICROSOFT POWERPOINT 97

◆  GREETINGS WORKSHOP or

MICROSOFT PUBLISHER 97

DON’T TRASH THE EARTH

8 Productivity in the Classroom More tips can be found at: www.microsoft.com/education/curric/activity/



In this activity, you will have the

“honor” of taking out the house-

hold trash every night for a

week. You will record the weight

of the trash in a worksheet,

chart the results for three weeks,

and analyze the  data. Finally, you

will create a presentation about

your findings.

Collecting the Trash
SOFTWARE: None

WHAT TO DO: Begin by telling

every family member to “leave

the trash! You will take it out.”

If possible, set up a temporary

Recycling Station at home for

(1) glass;  (2) metal cans; (3) no-

deposit, non-returnable plastic

bottles; (4) newspapers and

magazines; and (5)  returnable

bottles. Be sure to have a sepa-

rate garbage bag or container

for each kind of recyclable.  

Creating a Worksheet
SOFTWARE: Microsoft Excel

WHAT TO DO: Open  Microsoft

Excel and set up a “Don’t Trash

the Earth!” worksheet following

Example 1. You will use this

worksheet to record the weight

of each category of trash each

night. Print this chart out and

post it close to where you keep

the trash. 

Every time you take out the

family trash, you  should weigh it

and record its weight on the

chart.  A simple method would

be to weigh yourself first, then

weigh yourself again while hold-

ing a bag of garbage. NOTE: Even

if you do not have a bathroom

scale, you can figure out the aver-

STEP 1

DESCRIPTION

STEP 2

DON’T TRASH THE EARTH

Example 1: “Don’t Trash the Earth” worksheet created in Microsoft Excel

Student Activity

U.S. TRASH PRODUCTION 
1960-1990

YEAR WASTE POPULATION
(million tons/year)        (millions)

1960 87 179

1965 104 190

1970 121 203

1975 136 214

1980 150 227

1985 166 238

1990 182 249

Productivity in the Classroom 9More tips can be found at: www.microsoft.com/education/curric/activity/



age weight of a garbage bag used

at home.  For example, a large (39

gallon capacity) garbage bag full

of trash weighs about 7 pounds.

Keep count of how many bags

you dispose of each day and

enter their total approximate

weights on the chart. 

At the end of three weeks, after

all of your data has been collect-

ed, reopen your “Don’t Trash

the Earth” worksheet in

Microsoft Excel and type in the

data you collected. 

Charting Your Data
SOFTWARE: Microsoft Excel

WHAT TO DO: Once your work-

sheet is complete, decide what

data to graph. For example, you

might compare your own indi-

vidual trash production per year

to the class average production

or  to the average U.S. citizen’s

trash production. You might also

show the U.S. trend in trash pro-

duction using the data in the

chart on the previous page.

Presenting Your
Research
SOFTWARE: Microsoft Powerpoint

WHAT TO DO: After you have cre-

ated your charts, work in teams

of four to create a presentation

in PowerPoint. Consider the fol-

lowing areas for inclusion in

your presentation:

◆ Research trash disposal and

recycling locally and in the U.S.

in general. Is recycling mandato-

ry or optional?  Is garbage dis-

posed of in landfill?  How much

does recycling help the environ-

ment?  What kind of trash is not

biodegradable?  What happens

to non-biodegradible materials

in landfills? Can landfills or

“dumping” pollute?

◆ Think of all the things that

produce household trash. Is

there anything we could change

in society and in our families to

produce less trash?                  

Start a Recycling 
Campaign!
SOFTWARE: Greetings Workshop or 
Publisher 97

WHAT TO DO: Begin a recycling

campaign in your school or

neighborhood with the title

“Reduce, Reuse, Recycle” or

come up with a title of your

own. Events surrounding the

campaign can include a recy-

cling awareness night or school

rally.  

Use Greetings Workshop to

create invitations for the event

and flyers to generate aware-

ness of recycling issues as well

as upcoming recycling events

(see Example 2).  Plan ways to

effectively distribute these fly-

ers so that they help people

learn more about the issues. ■

STEP 5

DON’T TRASH THE EARTH

STEP 3

STEP 4

10 Productivity in the Classroom More tips can be found at: www.microsoft.com/education/curric/activity/
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Date  ________________

Dear Parent,

We are about to start on an exciting new project called,

“Don’t Trash the Earth!” and we need your help!  

All you need to do is to allow _________________________ to remove all of the trash

from your home for the next 3 weeks.  No one else should dispose of it, because

____________________ needs to weigh the trash before it leaves home.  If possible,

allow ____________________  to set up some “recycling” garbage bags or bins.  If

your family doesn’t recycle, this trash should be separated at home, but can be

thrown out with other trash after it has been weighed.

“Don’t Trash the Earth” is a project that will help teach your child some very

important skills.  In a hands-on, real-life setting, students will learn how to apply pre-

calculus math skills and computer graphing skills, and will learn how to use spread-

sheets with Microsoft Excel.  In addition, they will investigate environmental science

and learn about recycling.

The project will finish up with class presentations.  We hope you will come to see

them!

Sincerely,

____________________________________________

P.S.  If possible, set up a temporary Recycling Station at home for 1. glass, 2. metal

cans, 3. no-deposit, non-returnable plastic bottles, 4. newspapers and magazines,

and 5. returnable bottles.  Preferably, students should have separate garbage bags

or containers for each kind of recyclable.  

SURVEY 

STUDENT’S NAME

Productivity in the Classroom 11More tips can be found at: www.microsoft.com/education/curric/activity/



INTERMEDIATE

ALL ABOUT ME

In this lesson, students will create

and deliver an autobiographical,

multimedia presentation.

◆ To introduce students to the

concept of multimedia commu-

nication 

◆ To practice public speaking, and

to introduce the technology that

facilitates a public presentation

◆ Knows how to create an elec-

tronic slide presentation using

Microsoft® PowerPoint®

◆ Is familiar with the features in

Microsoft® Word

Approximately one week

Ask students if they can think of a

way we can “talk” to other people

without using words at all. One

good answer is through sign 

language. Discuss other ways to

communicate through sounds,

gestures, mime, pictures, music,

or video. Explain that “multime-

dia” means communicating to peo-

ple through visual images, sounds,

and written words. And because

multimedia presentations use a

variety of media, the information

is more clear, more interesting,

and more exciting. Then tell stu-

dents that they are going to create

an autobiographical multimedia

slide show called “All About Me.”

It will include images, written

words, sounds, music, and even

their own voices! 

TIP!  To help students gets start-

ed, develop your own “All About

Me” worksheet and turn it into

PowerPoint slides while the class

watches. 

TIP! There should be very 

little written text on a slide. 

If your students want to write

more, encourage them to use

notes. To create speaker notes

in PowerPoint, have students

switch to Note Page View by by

choosing Notes Page from the

view menu. Click in the text box

at the bottom of the screen and

begin typing.

REQUIRED SOFTWARE

◆  MICROSOFT POWERPOINT 97

◆  MICROSOFT WORD 97

OPTIONAL SOFTWARE

◆  MICROSOFT ENCARTA 97

ENCYCLOPEDIA

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

◆ Some students may wish to present a biography of someone

famous. Invite these students to research their subject using

Internet Explorer or Microsoft Encarta 97. 

◆ Students may also do a biography of a friend or relative.

Encourage them to prepare an interview questionnaire on

Microsoft Word. You may wish to preview students’ questions to be

sure they are appropriate and not personally invasive. 

E x t e n s i o n  A c t i v i t i e s

“All About Me” slide created in Microsoft Powerpoint

12 Productivity in the Classroom More tips can be found at: www.microsoft.com/education/curric/activity/
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In this activity, you will use

PowerPoint to create a multime-

dia presentation called “All

About Me.” 

Planning the Content
SOFTWARE: None 

WHAT TO DO: Think about all of the

things you would like to include

in your presentation and jot

them down on a piece of paper.

Include information such as

where you live, how many peo-

ple are in your family, and what

your hobbies are. You might

also include your favorite foods,

what you want to be when you

grow up and the funniest thing

that ever happened to you. 

Divide this information into  dif-

ferent categories. These cate-

gories will become your slides in

your PowerPoint presentation.

Now think about the design and

layout for each slide. What words

do you want to include on each

slide? What artwork or charts do

you want to include?

Creating an Outline
SOFTWARE: Microsoft PowerPoint

WHAT TO DO: To outline your pre-

sentation using PowerPoint, fol-

low these steps:

◆ Open PowerPoint.

◆ Click Blank Presentation.

◆ Choose Title Slide layout (top

left hand corner of row 1). 

◆ Click in “Click to add title” text

box, then type “All About Me.” 

◆ Click in “Click to Add Subtitle”

text box, then type your name.

◆ Switch to Outline View to orga-

nize your thoughts for your pre-

sentation. Choose Outline from

the View Menu (see Eample 1.)

◆ To add text to this slide, press

ENTER, and then press TAB to

indent the text beneath the

heading. Type your text.

◆ To add another slide to the

STEP 1

DESCRIPTION

STEP 2

ALL ABOUT ME

Example 1: Presentation outline using Outline View in Microsoft PowerPoint 
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presentation, press ENTER at

the end of slide 1 in the outline,

type your second category

heading, and press ENTER. You

may need to click the Demote

button to change this text to a

slide rather than text below

slide #2.

TIP! To learn more about work-

ing in Outline view, ask the Office

Assistant about “Outline View.”

Creating the Slides
SOFTWARE: Microsoft PowerPoint

WHAT TO DO: Here are a few

extra tips to consider when

creating a slide presentation in

PowerPoint: 

◆ Slide Order: To rearrange

the order of your slides,

choose Slide Sorter from the

View menu. Just click and drag

a slide where you want it to go.

◆ Slide Transitions: To apply

transitions between your

slides choose Slide Transition

from the Slide Show menu.

Click the dropdown arrow next

to “No Transition,” scroll down

to bottom of list and choose

Random Transition.  If you

want to add sound effects to

your slide transitions, click

Sound, then select a sound

option (note:  you may want to

use sounds on only a few

slides).  

◆ Graphics: Choose Picture

from the Insert menu, then

choose ClipArt, From File or

From Scanner.

◆ Custom Animation: You can

add interesting animations on

each slide in your slide show.

Go to the slide you want to 

animate. Choose Custom

Animation from the Slide Show

menu. For step-by-step instruc-

tions on how to create a cus-

tom animation, ask the Office

Assistant about “animated

slides.”  

◆ Record Narration: You might

want to add narration to your

slide show.  With PowerPoint

97, you can do that! Choose

Record Narration from the

Slide Show menu.  For help, ask

the Office Assistant how to

“record narration.”

◆ Speaker Notes: To remember

key points during your presen-

tation, you may want to create

speaker notes. Choose Speaker

Notes from the View menu.

Type your notes in the dialog

box.  These notes are added to

your notes page. Ask the 

Office Assistant about “speaker

notes.”

◆ Rehearse Timings : Time your

presentation by choosing

Rehearse Timings from the

Slide Show menu.  Run through

each slide of your presenta-

tion.  Click the right arrow to

go to the next slide. You can

view the timings in the Slide

Sorter View.     ■

ALL ABOUT ME

STEP 3

14 Productivity in the Classroom More tips can be found at: www.microsoft.com/education/curric/activity/
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INTERMEDIATE/MIDDLE SCHOOL

PLANNING A 
SCHOOL EVENT

In this lesson, students will

improve their writing skills while 

learning the fundamentals of

pitching a publicity campaign

for a school-wide event. By cre-

ating announcements, flyers,

invitations, special calendars,

and banner advertisements, stu-

dents become more personally

in-volved in this activity, and

will have an opportunity to

showcase their creative writing

talents. 

◆ To encourage students to use

written language in creative,

new ways 

◆ To explore ways of developing

an effective publicity campaign

◆ To motivate artistic expres-

sion and diverse thinking 

◆ Has basic skills for using a

computer

◆ Is familiar with navigating

around design programs such

as Microsoft® Publisher 97 and

Microsoft® Greetings Workshop

◆ Is familiar with the World

Wide Web

Approximately 2-4 weeks

Explain to students that they

will be planning a school event 

and that the success of any

event requires effective pro-

motional materials and adver-

tisements. Ask students to

bring in their favorite maga-

zine advertisements and dis-

cuss what they like about

these ads. Why do they think

the ads are so effective?

Encourage them to talk about

the importance of color, lay-

out, message, type style, and

illustrations in overall design.

In addition, brainstorm vari-

ous elements that should be

included in the creation of a

poster or flyer promoting a

special event such as: the

name of the event, date and

time, location, admission fee

(if any), and eye catching

graphics. Then have students

decide on the type of event they

would like to plan. Divide the

class into teams and assign

each one a special publicity task

– such as designing a flyer or

creating invitations – that will

help make the event a reality.

OBJECTIVES

SUMMARY

PREREQUISITE SKILLS

TIME ALLOTED

RECOMMENDED SOFTWARE

◆ MICROSOFT PUBLISHER  or

◆ GREETINGS WORKSHOP

OPTIONAL SOFTWARE

◆ INTERNET EXPLORER 

Opening screen from Microsoft Greetings Workshop

HOW TO BEGIN

Productivity in the Classroom 15More tips can be found at: www.microsoft.com/education/curric/activity/
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In this activity, you will work

with classmates to develop pro-

motional materials for a school-

wide event.   

Designing a Flyer
SOFTWARE: Microsoft Publisher 
or GreetingsWorkshop

WHAT TO DO: Creating promotion-

al materials for any event is sim-

ple with Publisher 97 or Greetings

Workshop!

One or more teams should

design a flyer or sign advertis-

ing the event. Keep in mind that

the name of the event should

occupy a central position. Text

should be in large type size and-

specify date, time, and location. 

From the opening screen

menus in Publisher 97 click 

the Flyers PageWizard.  In

Greetings Workshop, click Signs

and Flyers Project.  There will

be a number of templates to

choose from, or you can create

your own. Give your flyer visu-

al appeal by including some

graphic elements from the Clip

Gallery in Publisher 97 or

Greetings Workshop.

Simplicity is the key to effective

advertising.  When creating your

flyers or any other promotional

materials, be sure that they are

straightforward, uncluttered, and

easy for your audience to read.

Now place a copy of your com-

pleted flyers on every school bul-

letin board (the more the better!)
.

Creating a Calendar
SOFTWARE: Microsoft Publisher 
or Greetings Workshop

WHAT TO DO: A one-month calen-

dar can be a great way to high-

light the date for the big event.

Use the Publisher Calendar

PageWizard or the Greetings

Workshop Calendar project to

create an upbeat One-Month

calendar. Greetings Workshop

has several calendar styles (see

Example 1) which can be cus-

tomized to suit any need.

If these styles don’t quite fit

the bill, choose the Blank calen-

dar option. You can add text,

pictures, and other graphic

items selected from the pro-

gram’s clip art collection. When

STEP 1

DESCRIPTION STEP 2

PLANNING A SCHOOL EVENT

Example 1: Book Fair calendar created in Greetings Workshop

16 Productivity in the Classroom More tips can be found at: www.microsoft.com/education/curric/activity/
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finished, distribute the calendar

to family and friends.

Creating Banners
SOFTWARE: Microsoft Publisher or
Greetings Workshop
WHAT TO DO: Design one or more

banners for wall decoration at

the event. Banners can contain

text as well as graphics and the

Banner PageWizard in Publisher

97 or the Banner Project in

Greetings Workshop makes it

fun and easy to create a banner

for every need.

The text message should be com-

pelling and reflective of the spirit of

the event. The banner “Broadway

Bound” (see Example 2) was creat-

ed in Publisher and was the per-

fect headline for a banner created

to publicize a local school musi-

cal.  The same banner can be

created in Greetings Workshop.

Designing Invitations 
SOFTWARE: Greetings Workshop or
Publisher 97
WHAT TO DO: Create special greet-

ing-card style invitations for the

event using the Greeting Card

option in Greetings Workshop or

Publisher 97 and send them to

members of the community.

Consider inviting the School

Superintendent as well as repre-

sentatives from local businesses.

With Greetings Workshop or

Publisher 97 you can also prepare

thank you notes to parents,

teachers, staff or students in

other classes who helped with

planning the event.

Creating a Web Page
SOFTWARE: Publisher 97,
Internet Explorer,
WHAT TO DO: Once all of your pro-

motional materials are com-

plete, consider promoting your

event in cyberspace! 

With Publisher, you can create

a Web page for any existing

Publisher document, including

calendars, greeting cards, and fly-

ers. To create a Web page, open

the publication that will serve as

the basis for this new Web page,

choose Create Web Site from

Current Publication under the

File menu, then follow on-screen

prompts to run the Design

Checker.  Publisher will scan your

document looking for design and

layout elements not suited to

publication on the World Wide

Web.  It can also test to see if your

publication will download quickly

when a visitor accesses it

through a Web browser.  

You can publish your Web site

directly to the Web, or publish

to a folder.  When you publish to

a folder, you can then import

this folder to a new or existing

FrontPage 97 (or later version)

Web site.  

To give your Web site more

appeal, use Internet Explorer

to browse the Microsoft Clip

Gallery Live Web site and

choose from over 1,000 clip art

images that can be down-

loaded.These images will pro-

vide the perfect finishing touch

to any Web sites             

Recommended Web Site
◆ Microsoft Clip Gallery Live

www.microsoft.com/

clipgallerylive/                       

◆ Greetings Workshop

greetingsworkshop.msn.com

◆ Microsoft Publisher

www.microsoft.com/

publisher/

◆ In & Out of the Classroom

with Microsoft Publisher 97

or Greetings Workshop 

www.microsoft.com/

education/resource/

default.htm                           ■

PLANNING A SCHOOL EVENT

STEP 3

STEP 4

STEP 5

Example 2: Broadway Bound banner created in Microsoft Publisher 97
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MIDDLE/HIGH SCHOOL

CELEBRATETHE USA!

Working in teams of four, stu-

dents will take on the role of

marketers hired to promote one

state in the U.S.A. Each team will

research their state, create a

brochure highlighting its most

intriguing features, and give a 25

minute presentation that will

entice people to want to move

to, or visit that state.

◆ To introduce students to the

business of marketing and pro-

motion

◆ To guide students in the

process of creating effective 

presentations and promotional

materials

◆ To increase awareness of the

diversity of the United States  

◆ To build persuasive writing

skills 

◆ Knows the basic features of

Microsoft® Word 97, including the

Office Assistant 

◆ Is familiar with Microsoft® Excel

and its charting functions

◆ Has a basic knowledge of how

to use Microsoft® Internet

Explorer to gather research

◆ Can create a slide presentation

using Microsoft® PowerPoint® 

◆ Knows how to use the Page-

Wizard in Microsoft® Publisher 97

Approximately 4 weeks 

Have a general discussion with

students about the business of

marketing and promotion.  Ex-

plain the importance of knowing

who your “target market” or

audience is in order to create

effective marketing and promo-

tional materials that appeal to

that group. 

Instruct students that in this

activity they have just been hired

as marketers by the Governor’s

office to convince a specific tar-

get market to move to, or visit

“their” state. Then divide the

class into teams of four and

assign each team a state from a

different region in the United

States. Each team must keep in

mind the market they are target-

ing as they research their state,

prepare a comprehensive and

persuasive presentation about

that state, and create a com-

pelling brochure highlighting the

state’s most attractive features.  

REQUIRED SOFTWARE

◆  MICROSOFT WORD 97

◆  MICROSOFT EXCEL 97

◆  MICROSOFT POWERPOINT 97

◆  MICROSOFT PUBLISHER 97

OPTIONAL SOFTWARE 

◆  MICROSOFT INTERNET EXPLORER 

◆  MICROSOFT ENCARTA 97 

ENCYCLOPEDIA 

◆  MICROSOFT WORKS

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

◆ Have students create their own Web site for the state they are

promoting. The Web Site PageWizard in Publisher 97 will allow them

to select a one-page or multiple-page Web site which can be cus-

tomized with text, pictures and hyperlinks.  Web pages can also be

created with Microsoft Word 97 or Microsoft FrontPage.  

E x t e n s i o n  A c t i v i t y

State of Florida Web page from Internet Explorer

TIME ALLOTTED

18 Productivity in the Classroom More tips can be found at: www.microsoft.com/education/curric/activity/
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In this activity, you and three

other students will work togeth-

er as marketers hired to pro-

mote one state in the USA. The

objective is to prepare a slide

presentation and promotional

brochure designed to entice a

specific target market to want to

move to, or visit your state.   

Gathering Research
SOFTWARE: Microsoft Encarta 97
Encyclopedia, Internet Explorer

WHAT TO DO: Begin your research

by gathering as many facts and

as much information about the

state you’ve been assigned to

promote as possible. Each team

member will be responsible for

researching one category from

the Suggested Research Topics

including (a) job opportunities;

(b) cost of living; (c) weather;

and (d) recreation. Use the sug-

gested subject areas as a guide

and add to, or delete from, as

necessary. 

Encarta 97 Encyclopedia is a

great place to begin your

search.  Simply type in the name

of the state for a comprehensive

overview including the state’s

history, climate, agriculture,

and cultural points of interest.

You can also access a great

deal of information about your

state from the World Wide Web,

using Microsoft’s Internet

Explorer and a search engine

such as Yahoo or Lycos. Use the

state name or a place in the

state as a keyword, post ques-

tions on a traveler’s bulletin

board, or e-mail the state’s

Department of Tourism. 

Keep in mind that as mar-

keters, you need to discover

great and attractive things

about your state.  However, you

also need to be aware of the

negative aspects of your state

and determine the best way to

address them.

Now, using the research

you’ve gathered, decide who

the most logical target market is

for the state you will be promot-

ing. Is it families?  Or singles?

Perhaps people living in a par-

ticular geographic region? 

Organizing Your 
Ideas
SOFTWARE: Microsoft Word

WHAT TO DO: Each team should

meet at least twice a week to

share with team members all of

the information they have gath-

ered to date. Remember that the

different categories of your

research (job opportunities, cost

of living, weather, and recre-

ation) must work together in one

presentation so if recreation is

focusing on a particular area of

the state, perhaps weather

should focus on that area as well.

Meet with your teacher at

least once a week to review

your research. Are you getting 

appropriate information? Have

you read and understood the

information received? Does the

information cover the whole

state? What cities or areas of

the state are you focusing on? 

Organize your information

according to the four cate-

gories listed. One easy way to

start organizing your ideas is

by creating an outline.  The

Outline View in Word provides

a quick way to organize and

structure your report.  To learn

more about Outline View, ask

the Office Assistant how to

“create an outline.” 

Since your presentation is a

STEP 1

DESCRIPTION

STEP 2

CELEBRATE THE USA!
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SUGGESTED RESEARCH TOPICS

JOB OPPORTUNITIES COST OF LIVING

Growth Industries Housing  

Per Capita Income Food

Density of Population Transportation

City vs. Country Medical

WEATHER RECREATION

Seasonal Sports
Temperatures Culture 

Yearly Precipitation History

Sunshine/Cloud Cover Entertainment

Storms/Natural Events
Disasters



collaborative effort, take

advantage of Word’s many col-

laborative tools including these

options: Reviewing Toolbar,

Comments, Revision Marks,

and Versions.  Team members

can choose Versions from the

File menu, then choose Save

Now in order to note changes

they’ve made to the group

report.  Word displays the date

and time each version was

saved, along with the name of

the person who worked on the

document and any comments

regarding change they may

have made to the document.      

Mapping Out Your
Presentation
SOFTWARE: None

WHAT TO DO: Each team should

now begin to map out its pre-

sentation. Teams should meet

to identify the most interesting

or attractive features of the

state. What information would

be most appealing to your tar-

get market? What information

in each category is positive?

Which negative? What parts of

the information is quantifiable

and can be charted using

Microsoft Excel? In what order

should the information be pre-

sented to the audience?

Charting Data
SOFTWARE: Microsoft Excel

WHAT TO DO: Be prepared to 

create at least five charts.

(Microsoft Excel has 14 differ-

ent chart types.) Think about

the data you wish to present

and choose the type of chart

that you feel will present your

data most effectively (see

Example 2.)

To create a chart, highlight 

the range of data you want to

include in the chart. Then click

the Chart Wizard button.

Follow the instructions in the

wizard to specify the chart type

and options you want.

Keep in mind the following

points: Are your charts accu-

rate? Are they readable and

clear? Do they present interest-

ing information? 

Creating Slides
SOFTWARE: Microsoft Powerpoint

WHAT TO DO: Anytime you are

presenting information to a

group of people, you want 

that information to be as clear

as possible. PowerPoint enables

you to quickly and easily create

slide presentations that commu-

nicate information effectively.

Each team member should

create about 10 slides and be

prepared to present those

slides to the class in about five

minutes. The entire presenta-

tion should take no more than

25 minutes. 

You may also wish to add

hyperlinks to related Web sites

or other slides within your pre-

STEP 3

STEP 4

STEP 5

CELEBRATE THE USA!

Example 2: Examples of some common charts used for presenting data

COLUMN CHART  
To show recreation growth (or decline)—sports, culture,

entertainment, events—over the past 10 years

PIE CHART 
To show cost of living expenditures—housing, 

food, transportation and medical

LINE CHART 
To show population growth (or decline)

of your state during the last 25 years

SCATTER CHART
To show average temperature in your 

state during each of the twelve months of the year
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sentation  to create greater visu-

al interest.  For example, if you

see an image from Encarta that

you would like to include, simply

click on the picture, then click

Copy Image. Open up your

PowerPoint file and paste 

the image.  With Encarta, you

can copy and paste text, photos,

charts and maps into your

reports, and citations are added

automatically.

Since each team member will

be preparing their own slides,

be sure to use the Slides from 

File option under the Insert

menu to bring all team member’s

slides into one presentation.

Use a variety of visuals, with

as little text as possible on each

slide. The Apply Design com-

mand on the Format menu lets

you add a colorful background

to all slides (see Example 3).

With PowerPoint, you can also

include sound and narration to

create a multimedia presenta-

tion. Speaker notes can be

added to each slide by choos-

ing Speaker Notes from the

View menu.  

Print the Notes Pages to help

guide you when delivering your

presentation.  Be sure to add

slide transitions and anima-

tions to each slide.  These fea-

tures will make your slides

more interesting and provide

you with more control over the

pacing of your presentation.

Creating the
Brochure
SOFTWARE: Publisher 97
WHAT TO DO: Create an eye-catch-

ing brochure designed to

appeal to your target audience

and complement your presenta-

tion. The Brochure PageWizard

in Publisher makes it easy to

create a customized design. 

Click Create New Publication

on the File menu, and then the

PageWizard tab, if necessary.

Click the Brochure PageWizard

to step through the process of

creating a brochure.  Be sure to

include pictures and charts

from your research by replac-

ing the placeholder pictures

with the images you’ve gath-

ered. For additional help, click

the Show Help button on the

status bar. 

Of course, you’ll also want to

type your own information in

the brochure to replace the

placeholder text that Publisher

inserts.  You can type directly

into a text frame, or insert a

text file.  If your text doesn’t fit,

try editing the text to fit, chang-

ing the font size, margins, or

letter spacing, or continuing

the text in another text frame. 

Make multiple copies of your

brochure to hand out following

your oral presentation.  

The “Dress 
Rehearsal”
SOFTWARE: Microsoft PowerPoint
WHAT TO DO: Now do a “dress

rehearsal” of your presentation. 

The Rehearsal feature in

PowerPoint monitors the time

spent on each slide so you

don’t spend too much or too lit-

tle time on any one slide. You

can get timings for your slides

before you rehearse, or you can

get them automatically while

you rehearse. Ask  the Office

Assistant about “rehearsing.”

The Presentation
SOFTWARE: Microsoft PowerPoint

WHAT TO DO: Your presentation

can be given as a slide show 

on the computer, projected

onto a screen using an LCD

type panel, or you can create 

overhead transparencies.

Practice good presentation

skills, such as using a slow,

clear voice and avoiding dis-

tracting gestures. Following

your oral presentation, distrib-

ute copies of your brochure to

classmates. After all the class

presentations are finished,

choose the state you would

most like to visit based on the

information presented. ■

CELEBRATE THE USA!

STEP 7

STEP 8

STEP 6
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INTERMEDIATE/MIDDLE SCHOOL

NUTRITION TRACK

In this lesson, students will

learn about the importance of

a healthy diet based on the

USDA guidelines outlined in

the food pyramid. Students will

be required to keep a food

diary.  They will then create

various charts to analyze and

compare their diets to the

USDA recommended allowance

for each food group.

◆ To make students aware of

foods that are important for a

nutritious and healthy diet

◆ To gather, record, and chart

data for comparative purposes

◆ To critically interpret informa-

tion that is graphically dis-

played

◆ Basic knowledge of creating

worksheets in Microsoft® Excel

including skills such as format-

ting cells; calculating averages;

and creating and modifying

charts

◆ Basic knowledge of Microsoft®

Word including skills such as

formatting and editing text;

understands how to import

charts from Microsoft® Excel

Approximately 2 weeks

Introduce students to this les-

son by discussing the impor-

tance of a balanced diet.

Explain that by eating a well-bal-

anced diet, as suggested by the

“food pyramid” (above), people

get most of the vitamins and

nutrients their bodies need.

Use Internet Explorer to access

the pyramid on the U.S. Depart-

ment of Agriculture Web site.  

Explain that the base of the

pyramid represents that food

group which should be con-

sumed in the greatest quantity,

and the top of the pyramid, the

food group which should be

consumed sparingly. Explain

to students that they will learn

how their diet compares with

the pyramid by keeping a diet

log for one week.  

Recommended Web Site
◆ Department of Agriculture

http://www.nal.usda.gov

REQUIRED SOFTWARE

◆  MICROSOFT EXCEL 97

◆  MICROSOFT WORD 97

◆  MICROSOFT ENCARTA 97 
ENCYCLOPEDIA

OPTIONAL SOFTWARE

◆  INTERNET EXPLORER 

◆  MICROSOFT WORKS 

◆  MICROSOFT POWERPOINT

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED

•  For a more scientific study of vitamins and nutrients, suggest

that students look up “Nutrition” in Encarta 97 and then research

Essential Nutrients. The Personal Nutrition Interactivity area

allows for a personal analysis of one’s diet based on age, gender

and activity level.  

•  Have students create a slide presentation in Microsoft PowerPoint
which shows their favorite foods and the nutrition those foods pro-

vide. Or have them create a brochure in Publisher 97 recommending

foods that coincide with those suggested in the food pyramid.  

E x t e n s i o n s

Food pyramid downloaded from the Internet 

HOW TO BEGIN
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In this activity, you will keep a

record of what you eat over a

five-day period, and then com-

pare your diet with the United

States Department of Agricul-

ture’s recommended daily diet.

Create A Spreadsheet
SOFTWARE: Microsoft Excel or
Microsoft Works

WHAT TO DO: Open up a new work-

sheet in Microsoft Excel (Note:

Microsoft Works can also be used

for this project). In column A,

starting in row 2 (cell A2) list the

six basic food groups according

to the food pyramid. Use Internet

Explorer to access the food pyra-

mid on the Department of

Agriculture’s Web.

In cell B1 type Day 1, in cell C1

type Day 2.  Click the fill handle

in the lower right corner of the

cell (the pointer changes to a

black cross) and drag to high-

light through cell F1.    In cell G1,

type the heading “5-Day Avg” (5-

Day Average) and in cell H1,

type “Recommended Servings.”

Highlight columns A-H.  Click on

the Format menu and choose

Column, then choose Autofit

Selection to fit headings into

each cell.  To rotate text, high-

light B1:H1. From the Format

menu choose Cells, then click

the Alignment tab and in

Degrees, type 45.

In column H beginning in cell

H2, record the minimum number

of servings for each food group

that the USDA recommends.

TIP! Within your worksheet, you

can add a comment (as above) to

show the various foods in each

food group.  First, click a food

group cell, for example “Grains.”

Then, choose Comment from the

Insert menu.  A yellow box will

appear where you can now type

in the various foods that are part

of the Grains food group such as

bread, cereal, and pasta (see

Example 1).  (You might also

want to type in the recommend-

ed daily servings.) Now, if some-

one else is using your worksheet

and wants to find out more infor-

mation about each food group,

all they need to do is move the

cursor over the particular cell

they are interested in for some

“at-a-glance” information.

Recommended Web Site
◆ Department of Agriculture

http://www.nal.usda.gov

Keep a Diet Record
SOFTWARE: Microsoft Word or
Microsoft Works, Microsoft Excel

WHAT TO DO: Using Word or the

word processor in Microsoft

Works, create a docment in

STEP 1

DESCRIPTION

STEP 2

NUTRITION TRACK

Example 1: Microsoft Excel nutrition worksheet with cell comments 
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(Estimated one serving equivalents)

Grains:
◆  1 slice of bread;
◆  1 ounce of cereal;
◆  1/2 cup of cooked cereal, 

rice, or pasta

Vegetables:
◆  1 cup of leafy vegetables 

(measured raw) 
◆  1/2 cup  other vegetables 

(cooked or raw
◆  3/4 cup of vegetable juice

Fruit:
◆  1 medium apple, banana, 

or orange  
◆  1/2 cup cooked, chopped 

or canned fruit
◆  3/4 cup of  fruit juice 

Meats/Beans:
◆  2-3 ounces of lean meat, 

poultry, or fish
◆  1-11/2 cups of cooked 

dry beans 
◆  2 eggs
◆  4-6  tablespoons of peanut 

butter

Dairy:
◆  1 cup of milk /yogurt
◆  1 1/2-2 ounces of cheese

Fats/Sweets:
◆  Use sparingly

FOOD PYRAMID GUIDELINES



which you can keep a daily

record of everything you eat over

a five-day period. Then using the

Food Pyramid Guidelines figure

out how many servings of each of

the six food groups you had each

day. For example, estimated serv-

ings size for a tuna salad sand-

wich is 2 bread servings, 1 meat

serving, and 1 fat serving.  Now,

record in your Microsoft Excel

worksheet the number of serv-

ings of each food group you had

for each of the five days.

Compare Your Diet
SOFTWARE: Microsoft Excel

WHAT TO DO: Now you can calculate

how your diet compares, on aver-

age, to the USDA’s recommended

diet over a five-day period.  

To calculate the average num-

ber of servings of the first food

group for the five days type

=average(B2:F2) in cell G2.

Highlight G2:G7 and choose Fill

from the Edit menu, then

choose Down to calculate the

average number of servings for

the remaining 5 food groups.  

Chart the Results
SOFTWARE: Microsoft Excel

WHAT TO DO: Create a pie chart

showing the average number of

servings for each food group in

your diet over a five-day period.

Highlight B2:F7, select Chart

from the Insert menu and step

through the Chart Wizard to cre-

ate a pie chart (see Example 2).

Next, create a column chart

(see Example 3) that compares

your average number of serv-

ings to the minimum number of

servings the pyramid recom-

mends. First, highlight G2:H7.

Then select Chart from the

Insert menu and step through

the Chart Wizard to create a col-

umn chart.  Be sure to put a title

on your chart and label the X

and Y axes and the legend.  

Interpret the Results
SOFTWARE: Microsoft Word

WHAT TO DO: Use Word to write a

brief report describing what you

learned about your diet. Insert

charts created in Microsoft Excel

to visually represent how your

diet compares to the USDA rec-

ommended diet. Explain in detail

any steps you might take to

improve your diet. Which foods

should be eaten in larger quanti-

ties? Smaller quantities? Which

foods might be eaten in place of

high-fat, sweet snacks? ■

STEP 3

STEP 4

STEP 5

NUTRITION TRACK

Example 3: Column chart created in Microsoft Excel using the Chart Wizard

Example 2: Pie chart created in Microsoft Excel using the Chart Wizard
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MIDDLE SCHOOL

This lesson shows students the

benefits of using graphs to com-

municate information, answer

questions, and solve problems

as they investigate color distri-

bution in bags of M&M’s.

Working with actual bags of

candy, students will sort and

classify contents, summarize

their findings on a worksheet,

convert the numbers into

charts, and make predictions

about color distribution in

other bags of candy. 

◆ To introduce students to the

concept of graphing 

◆ To record color distribution in

spreadsheet format

◆ To utilize information ob-

tained through hands-on

research and analysis to write a

research report

◆ Knows how to use Microsoft®

Word to create a document includ-

ing formatting and editing text

◆ Knows how to create a

Microsoft® Excel worksheet

including creating formulas

◆ Can create presentations using

Microsoft® Powerpoint®

Approximately 2-3 days

Introduce students to the con-

cept of charting and discuss

why some data collections are

better represented by bar

charts, while others may be eas-

ier to interpret as line charts or

pie charts. Explain that while

there are no sure-fire rules that

state which chart type to select

for a particular data set, it is

important to select a chart type

which gets a message across in

the most effective way. Bar

charts, for example, allow for a

comparison of values within a

category, line charts emphasize

a progression of change, and pie

charts show the relationship of

a part to the whole.  

Tell students that this lesson

requires them to work with sev-

eral bags of candy of differing

weights. They will be sorting the

contents of each bag by color,

recording the number of can-

dies for each color, and repre-

senting observations in both a

worksheet table and several

types of charts.

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

“Candy Is Dandy” worksheet created in Microsoft Excel 97

TIME ALLOTTED

CANDY IS DANDY

REQUIRED SOFTWARE

◆  MICROSOFT WORD 97

◆  MICROSOFT EXCEL 97

OPTIONAL SOFTWARE

◆  MICROSOFT INTERNET EXPLORER 

◆ Students can use Internet Explorer to visit the M&M’s Web page

(http://www.m-ms.com/) and take a virtual tour of the factory. They can

send electronic mail to the company, indicating which colors they like

best and which colors they would like to see in future bags of candies.

◆ Encourage older students to summarize their research findings in a letter

to the Consumer Affairs Department, M&M/Mars, Hackettstown, NJ 07840-

1503. Students can use Microsoft Word’s Letter Wizard to get started.

E x t e n s i o n  A c t i v i t i e s
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You are going to conduct some

market research about M&M’s.

First, you will sort and classify

the contents of several bags of

M&M’s, summarize your find-

ings on a worksheet created in

Microsoft Excel, convert the

numbers into charts, and make

predictions about color distrib-

ution in other bags of candy.  

Color Distribution
SOFTWARE: Microsoft Word

WHAT TO DO: Work in pairs using

several small-size bags of

M&M’s, or two larger-sized

bags. Before opening any bag of

candy, take a guess about the

colors you expect to find. Do

bags of equal weight have an

identical number of candies?

Are all colors represented

equally or are some more popu-

lar than others? Does color dis-

tribution remain constant no

matter how small or large the

bag? Record your answers in a

Word document and save for

later reference.

Creating a Worksheet
SOFTWARE: Microsoft Excel

WHAT TO DO: Open a worksheet

in Microsoft Excel. In cell A1,

type the title Candy Is Dandy!

In row 3 beginning in cell A3,

type the headings Colors, Bag

1, Bag 2, Bag 3, Bag 4 and

Average. Type in the weight of

the bags of M&M’s in a com-

ment. Click in cell B3, choose

Comment from the Insert

menu, then type the weight in

the yellow pop-up (see

Example 1).  Now, anytime you

move your cursor over that

cell, the weight will appear.  

In column A, beginning in cell

A4, list all of the colors of

M&M’s you found in your bags.

Next, sort the list alphabetical-

ly by highlighting the cells and

choosing Sort from the Data

menu. Type Total in the cell

below your last entry.

Now you can format your

worksheet in a variety of ways.

Choose AutoFormat from the

Format menu and select the

format of your choice! 

Adding Formulas
SOFTWARE: Microsoft Excel

WHAT TO DO: Enter the number of

same color M&M’s in the corre-

sponding cells beginning with

Bag 1. Use the AutoSum func-

tion to total your columns.

Highlight cells B10:E10.  Choose

Fill from the Edit menu, then

choose Right. 

Now, you can automatically

calculate the average  number

of each color per bag. Click in

cell F4, then type the formula 

=average(B4:E4).  Highlight

cells F4:F10.  Choose Fill from

the Edit menu, the choose

Down. Format cells in the

Average column so that a whole

number is returned (i.e. no dec-

imal places) by using the

Decrease Decimal button on the

Formatting toolbar.

Interpret your data. Are some

colors more numerous? Do all

bags have the same number of

candies? Compare your obser-

vations with the findings of stu-

dents in other groups. Are the

same colors more numerous

from one group to another? Is

color distribution consistent in

bags of differing weights?

Creating Graphs
SOFTWARE: Microsoft Excel

WHAT TO DO: Use the Chart

Wizard in Microsoft Excel to pro-

duce at least two different charts

(see Example 2.). Choose the

chart types that best represent

STEP 1

DESCRIPTION

STEP 2 STEP 3

STEP 4

CANDY IS DANDY

Example 1: Cell Notes pop-up from Microsoft Excel
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the data such as bar chart or

column chart. You might chart

the distribution of colors in a

single bag, or the total number

of candies for all bags in your

sample.

Highlight cells A3:E9.

Choose Chart from the Insert

menu.  Click the Column chart

type, then click the Next but-

ton.  Click the Data Range tab,

and be sure Columns is select-

ed next to Series In, then click

Next.  In step 3 of the Wizard

(Chart Options), click the

Titles tab.  Add titles for the

chart and its axes.  Click the

Gridlines tab and experiment

with gridline options.  Choose

a gridline that makes it easier

to understand the data.  Click

Legend tab and choose a loca-

tions for the legend, then click

Next.  

Finally, have Microsoft Excel

place the chart as an object

on the original worksheet, so

that worksheet entries are

visible as you examine the

chart.

Writing The Report
SOFTWARE: Microsoft Word

WHAT TO DO: Students can use

Word to describe the research

project, the procedures they

employed to sort and count

the candies, and what the data

reveals about candy colors

and color distribution. 

Students should compare

their initial hypotheses about

the average number of candies

per bag and the expected color

distribution with actual survey

results have them copy and

paste spreadsheet and chart

data into Word where appropri-

ate (see Example 3.).

Reports should discuss the

advantages/disadvantages of

representing data in spread-

sheet tables, column charts,

bar graphs, or pie charts.

When is it best to use one

chart type instead of another?

What is the value of using

more than one bag of candy to

conduct this experiment? ■

STEP 5

CANDY IS DANDY

Example 2: Column chart created from Microsoft Excel Chart Wizard

Example 3: Report created in Microsoft Word with column chart
imported from Microsoft Excel
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FOR THE RECORD

In this activity, students create a

database that catalogs their

music collection of CDs and

tapes. Then they sort, analyze,

and print selected database

records in answer to questions

about their favorite music record-

ings and performing artists.

◆ To build a full-featured data-

base customized to meet specif-

ic needs.

◆ To learn how to search, sort,

analyze and manage a database 

◆ To evaluate the activity in a

thoughtful essay

◆ Knows how to launch a data-

base application in Microsoft®

Access or Microsoft® Works

◆ Knows the functions of Microsoft

Access or Microsoft Works includ-

ing  how to enter and correct

information; copy, change, and

delete information; change

appearance of text and numbers,

and print database files

◆ Knows database terms and con-

cepts such as table, record, and

field

◆ Knows how to browse the

World Wide Web using Microsoft®

Internet Explorer

Approximately one to two weeks

Ask students how they keep

track of important birthdays,

addresses, telephone numbers,

and appointments (e.g., wall or

desk calendars with important

dates penciled in, address

books, notes on the refrigerator,

sticky notes on a bedroom or

kitchen bulletin board).

Have students discuss the

advantages (inexpensive) and

disadvantages (easy to lose) of

conventional paper-based

memory boosters.    

Talk about what a computer

database is and what it does.

Encourage students to think

about the advantages of an elec-

tronic database (e.g., informa-

tion is stored in a single place;

it's readily available; it can't be

misplaced; it's easy to update;

it's always neat and legible; you

can search for records in a vari-

ety of different ways).

Explain to students that in this

activity they will build a data-

base to catalog either their

home music collection of audio

CDs, records, and cassette tapes

or the collection available in the

school music room/library.

Provide a glossary of terms

that students are likely to

encounter as they create a

database such as table, record,

field, query, filters, sort, lay-

out, database wizard, design

view, form view, datasheet

view, preview mode.

Recommended Web Sites
◆ Music Central Online

http://musiccentral.msn.com/

◆ The Ultimate Band List

http://www.ubl.com/

REQUIRED SOFTWARE

◆  MICROSOFT ACCESS 97

OPTIONAL SOFTWARE

◆  MICROSOFT WORKS 95

◆  INTERNET EXPLORER 

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED

MIDDLE SCHOOL

Music database entry in Microsoft Access 97

HOW TO BEGIN

Teacher Guide



In this activity, you learn how

to manage information by cre-

ating numbered records which

you arrange, retrieve, sort,

and print. You will use

Microsoft Access to catalog

your collection of music CDs,

records, and cassette tapes,

storing information about

recording artists, music

styles, and music tracks.

(Note:  With slight modifica-

tions, you can do this activity

using Microsoft Works 95.) You

will learn how to display this

information in a datasheet

(table format) or on a custom-

designed form. You will also

learn how to retrieve informa-

tion from the database using

the software's Find command.

By employing a variety of sort-

ing techniques to examine

your data, you will try to find

patterns or trends. The goal is

to develop a "wish" list of CDs

or tapes for distribution to

friends and family, so that

everyone knows exactly what

to get for your next birthday.

Finally, you will write a report

using Microsoft Word, evaluating

the significance of this activity.

Prepare a Database 
Template
SOFTWARE: Microsoft Access 
(or Microsoft Works);

WHAT TO DO: Launch Microsoft

Access, choose Database

Wizard from the Create a New

Database dialog box, then

double click on the "Music

Collection.mdz" wizard to cre-

ate a music collection data-

base. Name your new data-

base, then click the Create

button. (Note: If you use the

database module in Microsoft

Works 95, you can use a

WorksWizard to create a data-

base template. Works does not

have a Music Collection

TaskWizard.)

When the Music Collection

Database Wizard appears on

screen, choose the fields you

want to include in the various

database tables. Decide

whether you want to include

any optional fields (the ones

listed in italics) or any sample

data. Click the Next button.

Choose a style for the screen

display of your database form,

then click Next. Choose a

style for your printed reports,

then click Next. Finally, name

your database and decide

whether you want to include a

picture on all reports. When

you click Finish, your music

database will be ready to

accept data.

Enter Data
SOFTWARE: Microsoft Access

WHAT TO DO: If the Access Main

Switchboard dialog box is not

visible on screen, choose Open

database  from the File menu,

then double-click on the music

collection database. Click the

Enter/View Recordings button.

Begin cataloging your music

CDs and other recordings by fill-

ing out the Recordings form.

In the Recording Title field,

enter the title of your record,

for example, Falling Into 

You. As soon as you begin

entering data, Access automati-

cally assigns this record a

STEP 1

DESCRIPTION

FOR THE RECORD

Example 1: Record database entry using Microsoft Access

STEP 2
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Recording ID. This is the num-

ber Access uses to identify this

record to related tables in your

music collection database. 

Press the tab key to enter the

name of the recording artist.

Since this is a new entry, you

won't be able to select an artist

from the drop down list. Follow

Access' request to double-click

this name field. Doing so dis-

plays the Recording Artist form.

Enter "Dion, Celine" in the

Recording Artist field. In the

Notes field, enter the name of

the Producer and any other

information you would like to

include.   Click the Close button

to return to the Recordings

form. Now you can select Celine

Dion's name from the menu

drop down list.

Tab to the Music Category field,

and enter the appropriate

cateogory.  Tab to the Recording

Label, and enter the name of the

record label, for example, Sony.

Include the appropriate informa-

tion in the fields that specify

Format and Number of Tracks

(see Example 1).  You can enter

information about each track,

track title, and track length by

tabbing from one field to another

to move through the list. To cre-

ate a new record, choose New

Record from the Insert menu.

Sort Data
SOFTWARE: Microsoft Access (or
Microsoft Works)

WHAT TO DO: Develop new

insights about your music col-

lection by rearranging, sorting,

and filtering the data. After

you've entered a few records,

you can make them easier to

find by putting them in alpha-

betical order.  In Example 2 , we

sorted a collection of CDs in the

catagories of Jazz and Chants by

the name of the artist.

To sort the table alphabetical-

ly by artist, press F11 to open

your Music Collection Database

window. This shortcut key

works from any location in the

database. Click the Tables tab,

then double-click the Record-

ings object. The Recordings

Table opens on screen. Click the

column heading labeled

"Recording Artist ID." The entire

column will highlight. Then

click the Sort Ascending

Toolbar button (AZ).

Access then alphabetically

sorts the table data by

Recording Artist.   To resize col-

umn width for any column in the

table (Data- sheet view), click-

drag on the line divider to the

right of a column heading. To

resize a column so that all data

fit, double-click a column head-

ing's right divider line.

Find Data
SOFTWARE: Microsoft Access or
Microsof t  Works

WHAT TO DO: If you can't remem-

ber the name of a particular

recording, but you know the

name of its recording artist, use

the Microsoft Access Find com-

mand to locate the required

information. Follow these steps:

◆ Press F11 to open the Music

Collection Database window.

Click the Forms Tab, then dou-

ble-click the Switchboard

object. The Main Switchboard

window opens. Click the

Recording Artist category, then

click the binoculars (Find) icon

on the Forms toolbar. The Find

dialog pops up on screen. 

◆ Enter the name of the record-

ing artist in the Find What field.

Select All from the Search field

drop down list. Select Any Part

of Field from the Match drop

down list (that way you don't

have to enter the full name of

the Recording artist). Make

STEP 4

FOR THE RECORD

Example 2: Display of multiple recordings from more than one musical category in Microsoft Access

STEP 3



sure there's no check mark next

to the Match Case or Search

Only Current Field options.

◆ Click the Find First button.

Access searches the database

and returns a record that

matches the criteria you've

entered. If this is the record

you want, click the Close but-

ton. If this is the record, click

the Find Next button.

◆ To display all recordings of a

particular music category,

press F11 to return to the

Database Window. Click the

Tables tab, then double-click

the Recordings object. Click a

music category in the Music

Category ID column, then click

the Filter By Selection toolbar

button (the icon with both a

funnel and a lightening bolt).

Microsoft Access then displays

only those database records in

the music category you chose. 

To work with all records in the

database, click the Remove Filter

toolbar button. To have Microsoft

Access display recordings from

more than one musical category,

use the Filter by Form toolbar

button. Just follow these steps: 

◆ Have Access display all records

in the database by clicking the

Remove Filter toolbar button. 

◆ Next, click a Music Category

ID field that you want to include

in the search (e.g., Jazz) then

click the Filter by Form toolbar

button. 

◆ Access displays the "Record-

ings: Filter by Form" window.

Click the "Or" tab at the bottom

of this window, then select

"Chants" from the Music

Category ID drop down list  (see 

Example 3). 

◆ Next, click the Apply Filter

toolbar button. A new table

displays on screen containing

all Jazz and Chants records in

the database. You can also fil-

ter the database by mixing

items from several columns.

◆ Click the Print Preview

Toolbar button to see how your

database will look when print-

ed. Next, click the Print toolbar

button to have Access print a

copy of selected records.

Reporting the Results
SOFTWARE: Microsoft Word;
Microsoft Access

WHAT TO DO: To import an Access

table to a Microsoft Word report,

display the Access table you

want to import. Next, choose

Office Links from the Access

Tools menu. Finally, select

"Publish It with MS Word."

Access will save the table in RTF

format and automatically open

it in Microsoft Word.

Once you have database

information in MS Word, report

on the results. Who's your

favorite artist? What's your

favorite music category?

What's your favorite musical

instrument. Would any of your

other data collections benefit

from database management? ■

FOR THE RECORD

STEP 5

Example 3: The Recording Filter by Form window in Microsoft Access

Productivity in the Classroom 31More tips can be found at: www.microsoft.com/education/curric/activity/



MIDDLE SCHOOL

This lesson integrates language

arts with math applications as

students write letters to town

officials and local businesses

asking for favorite dessert

recipes, tabulate their respons-

es in a spreadsheet, and turn

their survey results into colorful

graphs. 

◆ To have students become

familiar with spreadsheet and

graphing fundamentals using a

real-world application

◆ To reinforce letter-writing and

research skills

◆ To gather data through survey

techniques

◆ Familiarity with Microsoft® Word

◆ Knows how to create a work-

sheet in Microsoft® Excel and use

its charting function

Approximately 5 weeks

Explain to students that this

lesson, which uncovers the

local community’s favorite

dessert recipes, has many com-

ponents including a) letter

writing, b) tabulating respons-

es, c) charting recipe data, d)

publishing a recipe book, and

e) “sampling” results.  Then list

the names and addresses of

town officials on the board and

have students choose someone

to write a letter to. If neces-

sary, call Town or City Hall for

a list of municipal officers. Or,

bring in copies of the area’s

Yellow Pages and have stu-

dents look up the names and

addresses of local businesses.

Plan on having students send

out several letters to increase

their chances of getting at least

one reply. 

Review with students the dif-

ferent parts of a letter, e.g.,

sender’s address, date, recipi-

ent’s address, greeting (saluta-

tion), and closing. as well as

how to address an envelope. 

Have them think about what

they are going to include in the

body of their letter, e.g., an

explanation of why they are

writing, the type of recipe they

would like to receive, how they

will use this recipe, plus spe-

cial thanks for helping out with

the project. 

REQUIRED SOFTWARE

◆  MICROSOFT WORD 97

◆  MICROSOFT EXCEL 97

OPTIONAL SOFTWARE

◆  MICROSOFT INTERNET EXPLORER 

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

◆ Have more advanced students use Microsoft Excel to calculate

what they should charge for their book of recipes in order to earn

a profit. First have them create a spreadsheet listing the cost of

project supplies (e.g. paper, toner, staples, stamps, envelopes).

Divide the total cost of the project by the total number of books

printed. The resulting calculation determines the “break-even” fig-

ure for the cost of each book. Arrive at a fund-raising goal. Divide

this number by the number of books printed. Add the result of this

calculation to the previously determined break-even cost to estab-

lish the book’s sale price.

E x t e n s i o n  A c t i v i t i e s

Hershey’s Web page from Internet Explorer

TIME ALLOTTED

YOUR JUST DESSERTS
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In this activity you will discover

your local community’s favorite

dessert recipes, publish them in

a recipe book and sell them to

raise money for a favorite local

charity. 

Writing Letters
SOFTWARE: Microsoft Word

WHAT TO DO: Put together a list of

town officials and municipal offi-

cers, or local businesses that

you would like to write letters to

for favorite dessert recipes. You

will add these names and

addresses to a data document

later in this lesson. Explain in

your letters that the goal of the

project is to collect a delicious

assortment of local desserts in

order to publish a book and

raise money. Ask them for a

small donation to offset the

cost, noting that any business

which supports the project will

be listed as a “patron” in the

recipe book. 

Compose your letters in

Microsoft Word.  Word has sev-

eral Letter templates, or start

with the time-saving Letter

Wizard (see Example 1).

Choose Letter Wizard from the

Tools menu to get started 

If you are printing letters on

school letterhead, be sure to

place a check mark in the “pre-

printed letterhead” box on the

Letter Format tab of Letter

Wizard. Then, enter the letter-

head’s location. If you are not

printing on school stationery,

complete the Sender’s name

and Return address on the

Sender Info tab of Word’s Letter

Wizard dialog. Word automati-

cally inserts this information in

the letter. 

Proofread and spell check

your letters before printing and

consider exchanging letters

with classmates for peer review

and evaluation. Since you will

be sending the same letter out

to a list of community members,

you can save it and merge the

address and name into each let-

ter. This is called a form letter.

Choose Mail Merge from the

Tools menu, click the Create

button, choose Form Letters,

then click the Active Window

button. You are now ready to set

up a table with the address

information where each letter

will be sent (note: you can also

keep this data list in Excel,

Access, or Works).

You are now ready to create

your data source file. Choose

Mail Merge from the Tools

menu, then choose Create Data

Source. Under Data Source,

choose Get Data, then choose

Create Data Source. This is

where you add the data. Click

the OK button, then name and

save your document. When you

see the Edit Data Source button,

STEP 1

DESCRIPTION

YOUR JUST DESSERTS

Example 1: Letter Wizard option in Microsoft Word

Productivity in the Classroom 33More tips can be found at: www.microsoft.com/education/curric/activity/

Student Activity



click it and enter the name and

address information for one of

your letter recipients. Click Add

New button to add the next per-

son on your list. Click the Merge

button in the Mail Merge Helper

dialogue box when you’re ready

to print your form letters.

To prepare envelopes or mail-

ing labels, choose Envelopes

and Labels from the Tools

menu. Ask the Ofice Assistant

about “envelopes” if you need

help.

Tabulating
Responses
SOFTWARE: Microsoft Excel
WHAT TO DO: Allow approximate-

ly 3 weeks for recipients to

respond to your letters.  Once

received, review responses and

identify the various dessert cat-

egories (e.g., cookies, cakes,

pies, fruit, etc.) from the

recipes received. 

Create a new worksheet in

Microsoft Excel with a separate

column for each dessert catego-

ry and sort the headings so

they display in alphabetical

order. Title you worksheets, for

example, “Our Town’s Favorite

Desserts” and then enter a “1”

in the appropriate dessert cate-

gory for each person who sends

in a reply (see Example 2).

Format column headings and

cell contents so that text is cen-

tered, and use Microsoft Excel’s

Autofill, AutoSum and Count

functions to add formulas and

data to your sheet. Ask the

Office Assistant for help.

Charting Responses

SOFTWARE: Microsoft Excel
WHAT TO DO: Create a Pie chart

using information in the Totals

row of the worksheet. Here’s

how:

◆ Highlight the cells in the

“Totals” row for each category.

(C12:J12). Choose Chart from

the Insert menu. Select Pie as

the chart type, then select the

chart sub-type Pie with a 3D

Visual Effect. Click the Press

and Hold to View Sample but-

ton to preview the chart, then

click Next.

◆ Click the Series tab. In the

Category labels box, type

=sheet1!c4:j4 then click Next.

Click the Titles tab, type

Dessert Favorites. Click the

Legend tab, then choose a

location for the chart legend.

Click Data labels tab, choose

Show Percent. This will make it

easy to determine which cate-

gory is actually the town

favorite. Click Next. Choose to

place the chart as an object on

the original worksheet, so you

can see worksheet entries as

you view  the chart (see

Example 3).

The Recipe Book
SOFTWARE: Microsoft Word,
Internet Explorer

WHAT TO DO: Every recipe should

have its own page in the book.

Create a template in Word with a

2-column table, to hold recipe

ingredients and instructions.

Add decorative elements such

as clip art or borders to place a

stylish design around the card.

Save and then copy the tem-

plate to a floppy disk or server,

and install it in the Templates

STEP 3

YOUR JUST DESSERTS

STEP 2

Example 2: “Favorite Desserts” worksheet created in Microsoft Excel

STEP 4
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folder of every computer that

students will use to prepare

their recipes.

Type recipe ingredients in the

appropriate cells. Word table

cells grow to fit the text you

enter and automatically wrap

within the cell when they reach

the end of a line.  Be sure to

delete any unused rows and

add new rows if necessary.

You may also want to use

Internet Explorer to browse the

Web for additional recipes to be

included in your books. 

Recommended Web Sites

◆ Hershey’s Chocolate

Recipe Index 

(http://www.hersheys.com/

recipes/recipe.index.html)  

◆ Godiva’s Super-Outrageous 

Ultra-Decadent Mega-

Chocolate Desserts 

(http://www.godiva.com/

recipes/recipes/chocolatier/

mega-chocolate/index.html). 

Once you are satisfied with the

look of your recipe book, think

about different ways you can

sell it to raise money for a local

charity.  You might also want to

write thank you letters to

everyone who sent in a recipe

and donation and include a

recipe book with your note.  

Sampling Recipies

SOFTWARE: None

WHAT TO DO: Decide on some

recipes you’d like to try. You

may want to invite survey

respondents for a tasting as a

way of saying “thank you.”  

Divide up the recipe ingredi-

ents and ask each student to

bring in one or two items. Use

the school kitchen to prepare

the desserts, but only teachers

should operate the stove or

oven. Make sure students clean

the kitchen before they leave!  ■

YOUR JUST DESSERTS

Example 3: Pie chart as an object on worksheet in Microsoft Excel

STEP 5
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MIDDLE SCHOOL

UNDERSTANDING
POETRY

In this lesson, students will use

the Internet or library to find a

poem they would like to

research and analyze. They will

then create an informal “work-

ing” paper on the poem, and

create a multimedia presenta-

tion to explain the poem to

classmates.

◆ To build skills in literary analy-

sis, expository writing and oral

presentations

◆ To enhance students’ appreci-

ation of poetry

◆ Can navigate Web sites using

Microsoft® Internet Explorer

◆ Knows Microsoft® Powerpoint

features including slide transi-

tions and adding sound effects

◆ Has basic knowledge of

Microsoft® Word

Approximately 1 week

One of the best ways for stu-

dents to develop an interest in

poetry is for them to explore a

variety of anthologies and single

poet collections. Regular expo-

sure to poetry will encourage

students to pick up poetry

books to browse through just as

naturally as they would pick up

story books.  

Begin a discussion with your

students about their favorite

poets.  Make a list of the poets

they name on the chalkboard.

Have students tell what they

know about each poet. You

might also suggest that they use

Internet Explorer and a search

engine such as Yahoo to locate

Web sites devoted to the poets

listed and to download some of

their poems. Students might

also enjoy visiting special poet-

ry pages for kids like “Zia Kids

Poetry Page.”

Explain to students that in this

lesson they are going to have the

opportunity to research and ana-

lyze a poem that has particular

meaning to them. 

Recommended Web Sites
◆ Zia Kids Poetry Page

http://www.zia.com/

educate/books/epoet/htm

REQUIRED SOFTWARE

◆  MICROSOFT WORD 97

◆  MICROSOFT POWERPOINT 97

◆  INTERNET EXPLORER

OBJECTIVES

SUMMARY

PREREQUISITE SKILLS

TIME ALLOTED

◆ For younger or less experienced students, make the lesson a

class project. Choose a poem and work through its analysis

together with the class. Then have students work in groups of

four to create a multimedia slide presentation in Powerpoint

about the poem. All four team members should participate in the

presentation.

A d a p t a b i l i t y

HOW TO BEGIN

Analysis of “Dream Deferred” in a Microsoft Word table

Teacher Guide



In this activity, you will use the

Internet to find a poem that you

like and then research, analyze

and present your interpretation

of that poem to the class. 

Researching Poems
SOFTWARE: Internet Explorer

WHAT TO DO: Use Internet Explorer

or a poetry book from the

library to choose a poem that

you would like to analyze.Share

any poems you find especially

interesting with others in the

class to build on and increase

everyone’s appreciation of

poetry.

Analyzing the 
Poems
SOFTWARE: Microsoft Word

WHAT TO DO: In this part of the

lesson you will be analyzing

your poem in writing. Retyping

your poem into a Word table will

make it easy to analyze your

poem line by line. Create a new

Word document. At the top of

the document type your name,

the title of your poem, and

today’s date. Press Enter three

times. To create a table, choose

Insert Table from the Table

menu, then OK (Word will auto-

matically add more rows when

you press tab while in last cell of

an existing table).

Click in column 1, row 1 of 

your table. Type the name of

your poem and the name of the

author, then press Tab key. Type

Analysis by, type your name,

and then press Tab key. 

In column 1, row 2 of the table

type the first line of the poem,

and then press Tab twice. In col-

umn 1, row 3 of the table, type

the second line of the poem,

then press Tab twice. Continue

these steps until you have your

entire poem typed in column 1

of the table - one sentence per

cell (see example below).

Click in each cell in the right

hand column and  write a line-

by-line explanation of the poem.

The written explanation should

sit beside the line of poetry it

explicates (see Example 1). The

STEP 1

DESCRIPTION STEP 2

UNDERSTANDING POETRY
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explication should include defin-

itions of unfamiliar vocabulary,

possible associations with the

poem’s images, and explana-

tions of the poem’s metaphors

and meaning.

Click in the document below

the table and describe why this

poem has personal meaning to

you. What do you identify with

and why? What happened to

you personally that helps you

understand the poem? Include

some autobiographical informa-

tion that you feel comfortable

sharing.

Keep in mind that this paper is

a “working” document, not a

polished piece. However, it

should be accurate in its inter-

pretation and must include

analysis as well as some autobi-

ographical information.  

Presenting the
Interpretation
SOFTWARE: Microsoft Powerpoint

WHAT TO DO: You are now going to

present your interpretation of

the poem to classmates by cre-

ating a five to ten minute slide

presentation using Powerpoint.

The presentation should have

three key elements:

1. The poem must be read aloud

at some time during the pre-

sentation — but not necessar-

ily at the beginning.

2. The presentation must help the

audience understand the poem.

3. The meaning of the poem

must be expressed both ver-

bally and through images and

sound added to your

PowerPoint presentation.

Presentation Tips
SOFTWARE: Microsoft Powerpoint

◆ Take advantage of  the many

features of PowerPoint to make

your slide shows creative and

interesting. Experiment with

color, backgrounds, text styles,

clip art, office art drawing tools,

slide transitions, and custom

animations.

◆ To animate a slide, choose

Custom Animation from the

Slide Show menu (see Example

2.) Consider using music,

sound effects, or recorded nar-

ration. Choose Record

Narration from the Slide Show

menu. To learn more about

adding music, sound and video

to your presentation, ask the

Office Assistant about “multi-

media.” To learn more about

using your PowerPoint presen-

tation on the Web, ask the

Office assistant about the

“Web.” 

◆ Practice your presentation

with a classmate. Be sure to

speak loudly, clearly, and

enthusiastically, but not too

fast. Time your presentation

by choosing Rehearse Timings

from the Slide Show menu. Run

through each slide of your pre-

sentation just like you would

deliver it, then click the right

arrow to move to the next

slide. You can review the tim-

ings in the Slide Sorter view.

The listener should take notes.

Is anything in the presentation

confusing? Is anything particu-

larly interesting or great?

Practice giving each other con-

structive feedback. ■

UNDERSTANDING POETRY

STEP 3
STEP 4

Example 2: Custom Animation option from Powerpoint ’s Slide
Show menu
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MIDDLE SCHOOL
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MAKING ENDS MEET

In this real-life simulation, students

create a monthly budget, showing

income earned from an imaginary

job versus estimated monthly

expenses. They then encounter

unexpected monthly expenses and

must adjust their budget to com-

pensate for those expenses.

Finally, they write a report evaluat-

ing the activity and what they

learned about “making ends meet.”

◆ To have students prepare a

monthly budget using Microsoft

Excel

◆ To estimate a monthly food bill

based on a weekly food menu

◆ To have students evaluate the

activity in a thoughtful essay

◆ Knows how to create a

Microsoft® Excel worksheet

including formatting cells, creat-

ing basic formulas, and saving

and printing the worksheet

◆ Knows how to use Microsoft®

Word to create a document,

including creating tables

◆ Can access the World Wide Web

using Microsoft® Internet Explorer

Approximately one week

Begin a discussion about the

“cost of living” by asking stu-

dents questions such as: “How

much do eggs cost?” What is the

bus fare from your home to

another part of town?” “What is

the  average rent for a one-bed-

room apartment?”

Next, discuss the average

beginning salaries for various

jobs. Suggest that students

research salaries by using

Internet Explorer to visit the Job

Market section of the The New

York Times Online. You can also

have students consult the Help

Wanted database published by

CareerPath.com for a list of jobs

advertised in selected 

newspapers around the country.

Explain to students that in this

activity they will prepare a

monthly budget comparing

income versus living expenses.

Recommended Web Sites
◆ The New York Times Online

http://www.nyTimes.com

◆ CareerPath.com

http://www.careerpath.com

REQUIRED SOFTWARE

◆  MICROSOFT WORD 97

◆  MICROSOFT EXCEL 97

OPTIONAL SOFTWARE

◆  INTERNET EXPLORER

◆  MICROSOFT WORKS

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED
◆ Explain to younger students that they will be trying to save

money from an allowance for a big purchase, such as a trip to

Disney World, or a new computer. Assign each student a fictitious

monthly allowance and have them create a Monthly Budget in

Microsoft Excel. How much money do they have left at the end of

the month? How long will it take to save for their special purchase? 

A d a p t a b i l i t y

HOW TO BEGIN

Monthly budget worksheet created in Microsoft Excel

Teacher Guide



In this activity, you will create a

monthly budget based on

income earned from a fictitious

job versus estimated living

expenses (including rent, trans-

portation, food, and leisure time

activities). If your expenses

exceed your income, you will

need to determine where to cut

back your monthly expenses in

order to “make ends meet.” You

will also encounter unexpected

monthly expenses which will

force you to adjust your month-

ly budget. Finally, you will write

a report using Microsoft Word,

evaluating the activity.

Prepare a Budget
Worksheet
SOFTWARE: Microsoft Excel

WHAT TO DO: Open a Microsoft

Excel worksheet and create a

monthly budget template, fol-

lowing Example 1. Be sure to

include the following expense

categories: rent, utilities, trans-

portation, food, medical

expenses, clothing, leisure

activities, and miscellaneous.    

In Cell B11, type  the formula:

=sum(B3:B10) or use Microsoft

Excel’s AutoSum function to

add up the cost of these

expenses. 

In Cell B13, type in your

monthly net income (your

gross income minus taxes and

other deductions). Job salaries

typically refer to income before

taxes. To determine how much

money you will actually have to

spend after taxes, if you make

$15,000 per year, estimate Federal

taxes at 8.5%.  If you make $20,000,

estimate taxes at 10%.  Federal tax

forms may be downloaded from

the Web using Internet Explorer

(http://www.1040.com). 

Now, in Cell B14, type: =B11.

And in Cell B15,  insert a for-

mula to calculate the differ-

ence between Income and

Expenses, such as: =(B13-B14). 

Estimate Expenses
SOFTWARE: Microsoft Excel

WHAT TO DO: Consult your local

newspaper or real estate maga-

zines to get an idea of how much

it costs to rent a house or an

apartment in an area you would

like to live. Type in the monthly

rent and the estimated cost of

utilities (gas and electric) in

your worksheet. 

Next, assume the cost of trans-

portation (car payment, insur-

ance, gas) to be $220.00.

For the other items in your

budget (other than food), esti-

mate your monthly expense and

type in that amount in the

appropriate cell. 

Create a Food Budget
SOFTWARE: Microsoft Word;
Microsoft Excel

WHAT TO DO: To determine your

monthly food budget, open a

Word document and chooseSTEP 1

DESCRIPTION

STEP 2
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Example 1: Monthly budget worksheet created in Microsoft Excel

STEP 3

Student Activity



Insert Table from the Table

menu. Design a Weekly Menu

table similar to the one in

Example 2.

Use this table to write down

what you plan to eat and drink

at each meal for one week. Be

sure to include snacks.

Now, figure out what you must

buy at the grocery store to pro-

duce this menu. In a Microsoft

Word document, list the items

needed according to categories,

such as fruit, meat, dairy, and

the quantity of each item. Print

out a copy of your food list.

Then, visit a local supermarket

and list the prices of the items

on your list according to quanti-

ty. (For example, for two cans of

soup at $1.15 each, list $2.30.)

Add the total cost of your

weekly food budget. Multiply by

four and one half weeks to get

an estimate of your monthly

food budget. Type this number

into the  food category of your

monthly budget.

◆ TIP! To create a wider lay-

out for your Weekly Menu,

click on the File Menu and

then Page Setup and Paper

Size. Then in the Orientation

Box, click on Landscape. 

◆ TIP! Number table pages by

choosing Header and Footer from

the View menu. Click the Switch

Between Header and Footer but-

ton on the Header/Footer toolbar

to jump to the Footer section,

enter Page, then click the Insert

Page # button.

◆ TIP! Remember to choose

Spelling and Grammar from the

Tools menu to spell check the

menu before printing.

Evaluate Your Budget
SOFTWARE: Microsoft Excel

WHAT TO DO: Once you have typed

in all of your monthly expenses,

your worksheet will show you

whether or not you are “making

ends meet.” Do your expenses

exceed your income? If so, you

must decide where to cut back

so that your expenses do not

exceed your income.

Now select one of the unex-

pected financial problems listed

below. Using Word, explain how

you would adjust your budget

to account for this unexpected

expense. Explain your rationale.

Then adjust your budget in

your Microsoft Excel worksheet to

account for this additional

monthly expense.

◆ You forget to pay our phone

bill and your phone service is

shut off. To turn it back on, the

phone company wants $50. 

◆ The lease on your apartment

is up for renewal and the land-

lord wants a 5% increase. How

much will your increase be?

How will you adjust your budget

to account for this increase?

◆ Your dog gets sick and the

medicine costs $150. 

Now use Word to write a

report explaining what you’ve

learned from this activity.

Include information copied from

your Excel worksheet as illus-

tration whenever possible.

Include ways in which you

might be able to stretch your

budget (for example, take in a

roommate to share the rent).   ■

STEP 4

MAKING ENDS MEET
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INTERMEDIATE/MIDDLE

ANIMAL LOGIC

This lesson gives students an

opportunity to study the

traits of three groups of ani-

mals and use the information

gathered to draw conclusions

about how the animals are

alike, and how they are differ-

ent. This exercise is designed

to give students an under-

standing of how shared char-

acteristics can be used in zoo-

logical classification.

◆ To show students how a col-

lection of objective traits can be

used to classify living things

◆ To apply the concept in a

three-way statistical analysis

◆ To form conclusions based on

statistical analysis

◆ Knows how to open and devel-

op a Microsoft® Excel worksheet

and use its many functions,

including the Autofilter

◆ Knows how to create a

Microsoft® Word document

◆ Can access information from

Microsoft®Encarta® 97Encyclopedia

◆ Knows how to use Microsoft®

Internet Explorer to access the

World Wide Web 

Approximately one week

Explain to students that zoolo-

gy is a science that deals with

animals. Zoologists learn

about animals by comparing

how animals are similar to and

different from each other. 

Tell students that in this les-

son they will compare three

groups of animals based on a

list of objective traits, and

draw conclusions about the

three animals. The first animal

in each group is the standard

to which the other two animals

will be compared. 

Invite students to discuss

qualities that all animals have

in common. What other sub-

groups for classification can

they suggest?

(Note: The animal groups

selected were chosen because a

comparison of traits might lead

to an unexpected conclusion.)  

REQUIRED SOFTWARE

◆  MICROSOFT EXCEL 97 or

MICROSOFT WORKS 

◆  MICROSOFT ENCARTA 97

ENCYCLOPEDIA

◆ MICROSOFT WORD 97

OPTIONAL SOFTWARE

◆  INTERNET EXPLORER

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

◆ Suggest that students research the taxonomy of the animals,

including their scientific names and placement on tree diagrams. 

◆ Have students write a short paragraph using Microsoft Word

explaining what they learned. 

◆ Introduce the topic of biodiversity. Use Encarta Biodiversity

Collage to learn more about the variety and complex 

interrelationships of other animals, plants, and living organisms.

E x t e n s i o n  A c t i v i t i e s

Screen shot of “Whales” from Encarta 97 Encyclopedia

42 Productivity in the Classroom More tips can be found at: www.microsoft.com/education/curric/activity/

Teacher Guide



In this activity, you will research

the characteristics of three dif-

ferent animals in three different

groups and conduct a compara-

tive analysis of those animals

using Microsoft Excel.

Making Predictions
SOFTWARE: Microsoft Word

WHAT TO DO: Look at the three

animal groups listed in Chart I.

Open a Word file and write down

a prediction about which two

animals in each of the three

groups you think might be most

alike and why. 

Researching the 
Animals
SOFTWARE: Microsoft Encarta;
Internet Explorer

WHAT TO DO: Use Encarta to

research each of the animals

listed below, putting together a

list of objective traits  for each

animal. You can select those

traits from the list in Chart II.

To limit your search, enter key-

words with modifications, such

as “whales, zoology.”  For more

information about these ani-

mals, you might also use

Internet Explorer to browse a

related Web site.

Setting Up
SOFTWARE: Microsoft Excel
WHAT TO DO: To organize your

research, open a Microsoft Excel

worksheet and type the head-

ing: “Animal Logic” in cell A1. To

set up your worksheet for the

Novice Group of animals, follow

these steps:

In row 2, starting in cell B2,

type the first three animals to

be compared (e.g., whale, shark,

elephant). Be sure to list the ani-

mals in the order they are listed

in Chart I. 

In Column A, starting at cell

A3, type a list of the objective

traits that apply to the whale --

Example 1: Animal Logic worksheet created in Microsoft Excel

STEP 1

DESCRIPTION

STEP 3

STEP 2

ANIMAL LOGIC
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CHART I–ANIMAL GROUPS

Novice Group Intermedia Group Advanced Group 

◆ whale ◆ bat ◆ spider

◆ shark ◆ owl ◆ shrimp

◆ elephant ◆ mouse ◆ ant

◆ Vertebrate/invertebrate

◆ Exoskeleton

◆ Warm-blooded/cold-blooded

◆ Number of legs

◆ Number of eyes

◆ Navigates primarily by ...

◆ Lays eggs

◆ Gives birth to live young

◆ Carnivore/herbivore/ omnivore

◆ Nocturnal/diurnal

◆ Has exterior fur/feathers/skin

◆ Lives in a social group/alone

◆ Lungs/gills

◆ Flies/swims/walks

CHART II–OBJECTIVE TRAITS



the first animal in the Novice

Group (see Example 1). Each

trait should be expressed as

briefly as possible. Modify col-

umn and row size so that animal

names and headings will fit.

In Column B, beginning in cell

B3, type the number 1 in the

cell next to each trait. The 1

indicates that the whale pos-

sesses each of the traits listed.

Using the information you’ve

collected, fill in the cells under

Shark and Elephant. For each ani-

mal, type the number 1 to indi-

cate that the animal possesses a

particular trait; type 0 to indicate

that the animal does not possess

the trait. For example, type 1 in

Cell  C3 to indicate that a shark is

an  animal with a vertebrate.

At the end of your list of traits

in Column A, type the word

Total. Then, in the cell to the

right of that, type the formula

=sum(B3:BX) where X is the

number of the last row in your

list of objective traits (see

Example 1). Press Enter.

Now, copy the formula in the

next two cells to the right. Ask

the Office Assistant how to “fill

adjacent cells.”

Interpreting the
Results
SOFTWARE: Microsoft Excel

WHAT TO DO: The first animal in

each list of three is the stan-

dard to which the two other

two animals are being com-

pared. The total score for the

first animal equals the most

traits that can be shared in the

analysis.

Compare the total similar

traits of the other two animals.

Which is most like the first ani-

mal? Is the conclusion as you

expected or is it surprising?

To see the traits that all three

animals have in common, use

AutoFilter. Just follow these

steps.

First, click cell B2, choose

Filter from the Data menu, then

select AutoFilter. A dropdown

arrow will appear next to the

name of each animal in row 2. 

Click the dropdown arrow

next to Whale in cell B2 and

choose “1.” Repeat the same

procedure for cell C2 and D2.

These are the traits all of the

three animals have in common.

Repeat the procedure above

and show the traits that none

of them have.

To turn off AutoFilter, choose

Filter from the Data menu, then

choose AutoFilter.

Reporting the
Results
SOFTWARE: Microsoft Word

WHAT TO DO: Record and interpret

your findings using Word. How

are the animals alike? How are

they different? Did any of the

results surprise you? Why or

why not? Zoologists ask these

questions all of the time.

Be sure you incorporate the

worksheet data created in

Microsoft Excel. Also, you can

copy pictures from Encarta

Encyclopedia or the Internet sites

into your Word document. ■

STEP 5

ANIMAL LOGIC

STEP 4

Example 2: Microsoft Excel formula to total list of objective traits
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MIDDLE/HIGH SCHOOL

NEWSWORTHY 
JOURNEY

In this lesson, students embark

on a historical journey to the

ancient civilization of Egypt or

Mexico to produce a newspaper

that reflects the cultural, politi-

cal, economic, and religious

views of the people living in

those societies at that time. 

◆ To familiarize students with

descriptive, narrative, and per-

suasive writing styles

◆ To use desktop publishing

techniques to produce a newspa-

per about the daily lives of peo-

ple who lived long ago

◆ To combine social studies with

language arts for an integrated

approach to learning

◆ Knows the basics of Microsoft®

Word or the word processing

program in Microsoft® Works

◆ Knows the basics of Microsoft®

Publisher 97

◆ Can access information from

Microsoft® Encarta® 97 Encyclo-

pedia

◆ Can access the World Wide Web 

Approximately four weeks

Brainstorm with students about

what life was like for men, women

and children living in ancient Egypt

or Mexico. Discuss class structure,

division of labor, the roles that peo-

ple played and the jobs they held. 

Explain to students that they will

be working in groups to produce a

newspaper reflecting life in those

societies at that time. Then have

students bring in copies of several

daily newspapers. Discuss the dif-

ferent sections of the paper includ

ing the Front Page, Business, Op-

Ed, Travel, and Arts & Leisure as

well as the various writing styles

each section employs. Point out

that articles in the Travel section

might use a narrative style, while

the Real Estate or Arts & Leisure

sections are better served by a

descriptive style. Editorials and

Advertisements, however, often

exhibit a persuasive writing

style. Discuss the differences in

these three writing styles.

REQUIRED SOFTWARE

◆  MICROSOFT ENCARTA 97

ENCYCLOPEDIA

◆  MICROSOFT WORD 97

◆  PUBLISHER 97 

◆  INTERNET EXPLORER

OPTIONAL SOFTWARE

◆  MICROSOFT ENCARTA

WORLD ATLAS  

◆  MICROSOFT WORKS 

OBJECTIVES

SUMMARY

PREREQUISITE SKILLS

TIME ALLOTED

◆ Younger students can produce simple newspapers using the

Newsletter option in Microsoft Greetings Workshop. First, have them

click on the “Signs & Flyers” project, and  choose a template from

the “Family News” category. They can then enter their own text and

choose different graphics from the graphics library.

A d a p t a b i l i t y

Ancient Egypt Web page downloaded from Internet Explorer

HOW TO BEGIN
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In this activity, you will work

with classmates to write and

produce a daily newspaper that

might have been published in

ancient Egypt or Mexico. 

Exploring
Newspapers
SOFTWARE: Internet Explorer
WHAT TO DO: Use Internet Explorer

to visit the Web pages of popu-

lar daily newspapers like USA

Today, The New York Times, and

The Washington Post. Examine

the layout of these newspapers

and read articles by profession-

al reporters. What sections do

these papers include? What are

the similarities and differences

between printed newspapers

and their online counterparts?  

Recommended Web Sites

◆ USA Today

http://www.usatoday.com

◆ The New York Times

http://www.nytimes.com

◆ The Washington Post

http://www.washingtonpost.

com 

Gathering Research

SOFTWARE: Microsoft Encarta 97;
Internet Explorer
WHAT TO DO: Use Encarta 97

Encyclopedia to research the

political, economic, and cultural

characteristics of ancient Egypt

or Mexico. Using the encyclope-

dia’s Find command, search for

articles with keywords such as

Egypt, Maya, and Pyramids.

Click “More Information” for a

list of related articles with addi-

tional facts about a selected

topic. Click WebLinks to view

links to related Web sites.  You

can also choose the Online

Library option to connect to the

Encarta online site with addi-

tional information on the topic.

Encarta text, maps, images, 

and image captions may be

copied and pasted into another

application. Configure encyclope-

dia settings so that you can select

Tools from the Features menu and

automatically launch Microsoft

Word. Information sources should

be automatically cited in your

document.  If not, you should add

them.   

You may also want to use

Internet Explorer to visit the Web

pages of sites highlighting the

civilizations of ancient Egypt

and Mexico (see Example 1).

Recommended Web Sites

◆ Egypt

http://users.skynet.be/sky69900/

◆ Mayan

http://www.wotw.com/MundoMa

ya/mexico/yucatan/

Writing the Articles
SOFTWARE: Microsoft Word

WHAT TO DO: Use Word to write

ar t ic les  for  the di f ferent  

sections of your newspaper.

Include at least one feature arti-

cle, a Letter to the Editor, a clas-

sified ad, and an advertisement.

You may also want to include

articles on sports, travel, arts

and leisure or business.

Use your imagination in creat-

ing your stories and advertise-

ments. For example, you might

write a general interest article

on the life of a typical teenager

in ancient Mexico. Or, for your

Example 1: The Home Page for a Mayan Web site in Internet Explorer

STEP 1

DESCRIPTION

STEP 3

STEP 2

NEWSWORTHY JOURNEY
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Egyptian newspaper, you might

write an article reporting on the

festivities surrounding opening

day at a new pyramid. You might

include an advertisement in

your Egyptian newspaper for

“Camels R Us,” a dealer in desert

transportation, or for a travel

agent specializing in luxurious

holiday stay at the Chichen Itza

Hilton.

Be sure to  illustrate stories

with pictures, tables, and charts

wherever possible.

After proofreading and spell

checking the story text, print

out a first draft to share with

group members for feedback or

use the Reviewing feature in

Word to make comments online.

Edit and revise your stories

where appropriate and then

submit stories to your teacher

for evaluation. Your teacher can

also make comments online.

Once you have received teacher

comments and suggestions,

revise your writing a final time

for publication.

Create Your Newspaper
SOFTWARE: Microsoft Publisher 97

Use the Newsletter PageWizard

in Publisher (any version) to cre-

ate your newspaper layout (see

Examples 2 and 3). Add visual

impact by using Publisher’s

Fancy First Letter option from

the Format menu to alter the

size of a paragraph’s first letter. 

Click the newsletter headline

and use the Design Gallery

option in the Tools menu to

change the style of the mast-

head.  You can do the same for

the table of contents and side-

bar, etc. Finally, import text

from articles already written.   ■

NEWSWORTHY JOURNEY

Example 2: The Bold newsletter template from Publisher 97

Example 3: Newsletter created with Publisher 97 Newsletter PageWizard

STEP 4
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HIGH SCHOOL

BUY LOW, SELL HIGH

This lesson will teach students

how to invest in corporate stocks

by creating investment “portfo-

lios.” Step-by-step instructions

will enable students to develop

worksheets that track their port-

folio’s performance over a speci-

fied time period and report the

results to the class. 

◆ To introduce students to the

stock market

◆ To design a worksheet that

calculates profit (or loss) for

any given investment

◆ To generate line graphs repre-

senting stock performance

◆ Knows Microsoft® Excel basics

and its many features including

creating worksheets and charting

◆ Knows how to create an elec-

tronic slide presentation using

Microsoft® PowerPoint®

◆ Knows how to access the 

World Wide Web using Microsoft®

Internet Explorer (optional)

Approximately six weeks to

three months

Introduce students to the Stock

Market summarizing its role in

U.S. economic history (e.g., the

great crash of 1929). Define

terms that students are likely to

encounter in their research such

as portfolio, dividend, and

price/earnings ratio (i.e. stock

price divided by stock earnings

per share.) Have students bring

in the business section of news-

papers that publish stock market

information and explain to them

how to read a stock quote. Have

each student choose five compa-

nies whose stock they want to

purchase. Explain that everyone

in the class will start with $1,500

as seed money to purchase

stocks at the current market

value and that they will track

their portfolio’s performance

over a period of time from six

weeks to three months. Finally,

discuss with students the effec-

tiveness of line charts in present-

ing their results.

REQUIRED SOFTWARE

◆  MICROSOFT WORD 97

◆  MICROSOFT EXCEL 97

◆  MICROSOFT POWERPOINT 97 

OPTIONAL SOFTWARE

◆  INTERNET EXPLORER 

◆  MICROSOFT ENCARTA 97 
ENCYCLOPEDIA

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED

HOW TO BEGIN

◆  Have students consider trading their stock (buying or selling

shares) during the specified time period. 

◆  Have students create a Summary worksheet of their invest-

ments. Columns should contain cells that reference initial invest-

ments, total shares owned, current price/share, and profit/loss

figures for every company in the portfolio. 

E x t e n s i o n  A c t i v i t i e s

Stock portfolio worksheet created in Microsoft Excel
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In this activity, you will invest

$1,500 in five different compa-

nies and then track the stock

market price of those compa-

nies over a period of time.

Research The Market
SOFTWARE: Microsoft Encarta,
Internet Explorer

WHAT TO DO: Choose ten companies

in which you think you would like

to invest. Using Microsoft’s

Internet Explorer and a search

engine such as Lycos or Yahoo,

access each company’s Web site

in order to gather as much back-

ground information as possible

about each company, including: 

◆ Type of company

◆ Number of years in business

◆ Summary of what the 

company does

◆ 1996 profits 

◆ 1997 profits (thus far)

Now, review the information

gathered and decide on five

companies in which to invest.

Find out the current selling price

per share for each company’s

stock. Decide how many shares

of stock you want to buy in each

company keeping in mind that

you have only $1,500 to invest.

TIP! Encarta 97 includes several

helpful articles about the stock

market. Use the encyclopedia’s

Find command to search for key-

words such as “Stocks and Bonds,”

“Finance,” and “Stock Exchange.”

TIP! Using Internet Explorer, visit a

Web site called “Investing for Kids”

(see Example 1) or “StockMaster,”

the stock market site referenced

in the Web Links section of

Encarta. Or, you can access a

wealth of business news and

financial information to track

the performance of selected

stocks by visiting the Web site

of “Microsoft Investor.”  

Recommended Web Sites
◆ Investing for Kids

http://tqd.advanced.org/3096

◆ StockMaster

http://www.stockmaster.com

◆ Microsoft Investor

http://www.investor.msn.com

Create A Spreadsheet
SOFTWARE: Microsoft Excel,
Microsoft Word

WHAT TO DO: Open Microsoft Excel.

Add 2 new worksheets to your

workbook so you have a work-

sheet for each of the five compa-

nies in your investment portfolio.  

TIP! Adding worksheets is easy.

Simply click Worksheet from the

Insert menu. Use the Office

Assistant to learn how to

rename a worksheet.

For each company’s work-

sheet, you will input (a) some

basic information about the

company, such as the company

Symbol (the unique symbol

assigned to a NASDAQ security)

and the name of the particular

Stock Exchange that lists the

stock; (b) an Initial Investment

section; and (c) a Daily Record

section (see Example 2). 

Here are some step-by-step

instructions to get you started

with your worksheets:

◆ In cell A1, type the company

name, for example, ACMEDIATE

Corporation

◆ Highlight A1:E1; then click

Merge and Center on the

Formatting Toolbar to center the

company name (see Example 3). 

◆ In cell A3, type “Symbol:”fol-

lowed by the company’s four-

letter symbol, for example,

ACME; in cell E3, type “Initial

Example 1: “Investing for Kids” Web site (from Internet Explorer) at
http://tqd.advanced.org/3096

STEP 1

DESCRIPTION

STEP 2

BUY LOW, SELL HIGH
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Investment” followed by the

total amount of money (number

of shares times the price per

share) you are investing in that

company. Your total investment

equals the total price paid for

the stock.

◆ In cell A4, type “Exchange:” fol-

lowed by the name of the

exchange listing the stock.

TIP! To enlarge a cell, point to 

the column border, the cursor

will change to a two-headed

arrow. Now, drag the column to

the desired width.   

TIP! Format all currency for two

decimal places by choosing

Cells under the Format menu,

clicking the Number tab, and

then selecting Currency under

Categories. In the Decimals

places enter the number 2 (see

Example 4.) 

Invest In Your
Companies
SOFTWARE: Microsoft Excel

WHAT TO DO: To create the Initial

Investment section of your

worksheets, try these tips:

◆ In cell A6, type “Initial Invest-

ment” and change to bold face

type.

◆ In cell A7, type “Date of

Transaction.”

◆ In cell C7, type “$/Share”;

in D7, “# of Shares Bought”; in

E7, “Total Investment”.

◆ Highlight A7:E7

◆ Right click the highlighted

cells, then choose Format cells.

◆ Click Alignment, select Center.

◆ In cell A8,  type the date of the

initial transaction 

TIP! At this point you may want

make four copies of the work-

sheet to use as a template for

each company’s stock that you

track. Select Move or Copy

Sheet from the Edit menu, click

the Create a Copy check box,

then repeat this procedure for

as many copies as you need.

◆ In cell C8, type the cost per

share (e.g., 20 3/4) as listed on

the stock exchange. Microsoft

Excel will automatically convert

this figure to decimals. Be sure

to format the number for two

decimal places. 

◆ In cell D8, type the number of

shares bought. In cell E8, type the

formula: =C8*D8 and press enter.

The total cost of your investment

will automatically be calculated.

Format to two decimals places.

The Daily Record
Section
SOFTWARE: Microsoft Excel

WHAT TO DO: To create The Daily

Record section of the work-

sheet, follow these steps

◆ In cell A9, type “Daily Record.” 

◆ In  cell  A10,  type  “Date of

Transaction”; in B10, “#/Shares”;Example 4: Format Cells dialog box

BUY LOW, SELL HIGH

Example 2: Stock portfolio worksheet created in Microsoft Excel

Example 3: Merge and Center icon on the Formula Toolbar

STEP 4

STEP 3
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in C10, “$/Share”; in D10, “Current

Value”; in E10, “Profit/Loss”.

◆ Highlight A10:E10 and center

and wrap text.

◆ Beginning with cell A11, high-

light the range of data in Column

A you will be entering on your

worksheet, for example ,

A11:A22. Right click the high-

lighted cells.  Choose Format

Cells.  Click the Number tab.

Click Date, then choose Type of

Date.  Click OK.

◆ In cell B11, type the number of

shares bought.  Ask the Office

Assistant “How do I fill down?”

◆ In cell C11, record the price of

your stock on the first date of

transaction. 

◆ In cell D11, type the formula: 

=B12*C12.

◆ In cell E11, create a formula

that calculates Profit/Loss by

taking the Current Value (D12)

minus the initial investment

(E8). The formula should refer

to D8 as an absolute reference-

=D12-$E$8. 

TIP! Look up “cell references” in

Office Assistant to learn more

about this term.  Ask the Office

Assistant how to format Column

E for currency.

Tracking Stocks
SOFTWARE: Microsoft Excel

WHAT TO DO: At the end of the

stock performance period, use

the Chart Wizard in Microsoft

Excel to create a line chart

showing “profit or loss” for each

stock you invested in.  

Highlight the range of data

you’ve entered on your work-

sheet, for example, E12:E23 (see

Example 5). Click Chart from the

Insert menu, then choose Line

and step through the procedures

for creating a line chart. Be sure

to add a chart title. Label the

chart’s X and Y axes (see

Example 6). Why does the line

chart do a better job of repre-

senting the stock data than a pie

chart? For more help, ask the

Office Assistant about “charting.”

Reporting The Results
SOFTWARE: Microsoft Word,
Microsoft PowerPoint

WHAT TO DO: Summarize your stock

market experience in a printed

report using Word and incorpo-

rate worksheets and charts

copied from Microsoft Excel. Or,

create a slide presentation using

PowerPoint. The presentation

should summarize the company’s

stock performance and any trends

that are apparent.                        ■

BUY LOW, SELL HIGH

STEP 6

Example 6: Line chart created in Microsoft Excel showing profit/loss.

Example 5: Highlighted data to create Microsoft Excel line chart

STEP 5
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HIGH SCHOOL

BRIDGING THE 
GENERATION GAP

Students get a real life lesson in

Sociology as they create a

hypothesis about the attitudinal

differences between generations,

test their hypothesis with a sur-

vey, chart their findings, and pre-

sent their answers to the class. 

◆ To introduce students to the

process of creating a hypothesis 

and testing its validity

◆ To familiarize students with

spreadsheet fundamentals

◆ To encourage thoughtful dis-

cussion about generational 

differences

◆ Knows the basics of Microsoft®

Word or the word processing

program in Microsoft® Works

◆ Knows how to create a basic

Microsoft® PowerPoint® presenta-

tion including inserting clip art

◆ Knows how to create a

Microsoft® Excel worksheet includ-

ing sorting and filtering data

Approximately four weeks

Explain to students that in this

lesson they are going to explore 

the differences between genera-

tions. Ask students: Is your atti-

tude about issues in life such as 

politics and family values the

same as somebody who is, say,

age 50? Do older people and

younger people think alike?  On

what subjects might they feel

differently? Is there really such  

a thing as a “Generation Gap?”  

Tell students that they are going

to find out for themselves. After

developing a hypothesis that

they believe reflects the differ-

ences between generations, stu-

dents will design and adminster

a survey to test their hypothe-

sis, and then chart their findings

and present the results to their

classmates.

REQUIRED SOFTWARE

◆  MICROSOFT WORD 97

◆  MICROSOFT EXCEL 97

◆  MICROSOFT POWERPOINT 97

OBJECTIVES

SUMMARY

PREREQUISITE SKILLS

TIME ALLOTED ◆ For more advanced students, have them design the survey

form in Microsoft Excel or Word. They’ll work with the Forms tool-

bar to add form buttons and boxes. For help designing a form in

Microsoft Excel, click the Office Assistant and type “Create a

form” in the search field.  

A d a p t a b i l i t y

HOW TO BEGIN

“Generation Gap” worksheet created in Microsoft Excel

Teacher Guide



In this activity, you will write

and administer a questionnaire

that compares attitudes and

opinions about certain issues,

based on different variables,

such as age, gender, or geo-

graphic region. You will then

analyze your results using

Microsoft Excel and report your

findings using Powerpoint.

Creating a
Hypothesis
Software: None

WHAT TO DO: Decide how you

think generations may differ

in their opinion on a particu-

lar topic. Team up with a

classmate and choose two

topics to study.  These will be

called Dependent Variables

because you are stating that

you believe that a person’s

beliefs about these topics

depends on their age. The

Independent Variable is

what causes the differences

in the dependent variables.

In this case, the independent

variable is the generation to

which the person belongs.

Choices for topics might

include: politics; TV violence;

movies; religion; technology;

women in the military; gun

control; family values; friend-

ship; and eating habits.

Now, decide exactly how you

think the dependent variables

will differ for the generations.

This is your hypothesis. For

example, if the topic is “TV vio-

lence,” the hypothesis might

be: Younger people think TV vio-

lence is fun and harmless, but

older people think it is dangerous 

and harmful.

Or if the topic is “women in

the military, the hypothesis

might be:” The older a person

is the more he or she will

believe that women in the mili-

tary should not be allowed in

combat.

Or if the topic is “friend-

ship:” Young people tend to

value friends more than family,

but older people tend to value

family more than friends.

Creating the Survey
SOFTWARE: Microsoft Word 

WHAT TO DO: Use Word to create

a survey form similar to the

one at the end of this activity.

With your partner, create five

statements for survey partici-

pants to respond to that will

accurately test your hypothe-

sis. Statements should be

designed to elicit answers like

“strongly agree” or “strongly 

disagree.”

Next, assign numerical values

for different attitudes toward

your statements. For example:

5 – Strongly agree 

4 – Agree  

3 – Neutral  

2 – Disagree  

1 – Strongly disagree

Present your survey state-

ments to the rest of the class

and see if the class can guess

your hypothesis and if the state-

ments accurately reflect the

hypothesis.

Administering the
Survey
SOFTWARE: None

WHAT TO DO: Decide on a mini-

mum number of people to be

surveyed. Set up tables in pub-

lic places, such as at a mall,

inside or outside a grocery

store, or at a movie theater.

Please note: You must have the

permission of your parents and

the survey site owner before

administering their survey. 

Be sure respondents fill out the

entire survey and thank them

for taking the time to do so.

Now, for each respondent,

average the numerical values of

their responses to the survey

statements and write this

“score” in the Key Code Average

box on the survey form.  

Analyzing the Data
SOFTWARE: Microsoft Excel 

WHAT TO DO: You are now ready

to analyze your survey data.

First, clarify your variables. For

example, independent variable:

Generation; dependent vari-

able: Political Beliefs. There

should be one column for each

dependent variable on your

worksheet (see Example 1). 

When entering data into your

worksheet, each response

(completed survey) should be

put in its own row and the

Independent Variable should go

in the first column.  

Even if you do not include this

information in your analysis,

STEP 1

DESCRIPTION

STEP 2

BRIDGING THE GENERATION GAP

STEP 4

STEP 3
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you should at least note how

many males/females there are

and what part of the world the

respondents were born in.

These differences may affect

your results, and are therefore

important to record.  Make these

the second and third columns.  

Next, sort the data based on

the generation group.  Then, cal-

culate the average score for

each dependent variable for

each group.

Using Microsoft Excel’s filtering

features, evaluate the data by

showing records that match

certain rules, or criteria.  For

example, show all records of

people who were born between

1946-1955 from the United States

that scored the highest for one

of your dependent variables.  

Finally, create charts that show

some trend in your data.

Presenting the
Answers
SOFTWARE: Microsoft Excel;
Microsoft PowerPoint

WHAT TO DO: Have each team pre-

sent their hypothesis and their

findings to the class.  Teams

may present their ideas on the

computer using Microsoft Excel

to show their graphs. Or, each

team can create a presentation

in PowerPoint  to demonstrate

with graphics, art, animations,

and graphs the hypothesis and

the various findings.             ■

BRIDGING THE GENERATION GAP

STEP 5

Example 1: “Generation Gap” worksheet created in Microsoft Excel



This is an anonymous survey to be used for a school project only. 
Thank you for your time!

Gender (circle one) Male Female

When were you born? (circle one)

1905-1915 1916-1925 1926-1935 1936-1945

1946-1955 1956-1965 1966-1975 1976-1985

In what state did you live as a child? _____________________________________________

If outside the U.S. , where? _________________________________________________

When you were a child, was your home? (circle one)

Urban Suburban Rural

What is your political affiliation? (circle one)

Democrat Republican Other ___________________________________

For each statement below, check one of the five boxes that follow to indicate the

extent to which you agree or disagree.

1. _______________________________________________________________________

_______________________________________________________________________

❒ Strongly Agree        ❒ Agree        ❒ Neutral        ❒ Disagree        ❒ Strongly Disagree

2. _______________________________________________________________________

_______________________________________________________________________

❒ Strongly Agree        ❒ Agree        ❒ Neutral        ❒ Disagree        ❒ Strongly Disagree

3. _______________________________________________________________________

_______________________________________________________________________

❒ Strongly Agree        ❒ Agree        ❒ Neutral        ❒ Disagree        ❒ Strongly Disagree

4. _______________________________________________________________________

_______________________________________________________________________

❒ Strongly Agree        ❒ Agree        ❒ Neutral        ❒ Disagree        ❒ Strongly Disagree

5. _______________________________________________________________________

_______________________________________________________________________

❒ Strongly Agree        ❒ Agree        ❒ Neutral        ❒ Disagree        ❒ Strongly Disagree

Reproduce for Student Use 

SURVEY 
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MIDDLE/HIGH SCHOOL

CREATING 
YOUR OWN WEB SITE

In this lesson, students will

learn to design Web pages

complete with text, graphics,

and hypertext links. After

adding backgrounds, naviga-

tion buttons, and audio-visual

effects, and revising their

work based on comments from

peers and teachers, students

will “publish” their projects on

the Internet for all the world

to see! 

◆ To have students create and

publish their own Web site

◆ To expand on student’s critical

thinking skills as they organize

information for distribution

over the Internet

◆ To define Internet terms like

ImageMap, HTML and Hyperlink 

◆ Knows how to open a docu-

ment in Microsoft® Word and to

use Word’s many features

◆ Knows how to use Microsoft®

Publisher 97

◆ Can access the World Wide Web

using Microsoft® Internet Explorer 

Approximately  two weeks

Provide a brief introduction to

the Internet and explain to stu-

dents that they will be creating

a Web site of their very own.

Introduce terms that they are

likely to encounter as they

develop pages for the World

Wide Web such as ImageMap

and Hyperlink.  

Now, have students talk about

and/or download Web pages

they visit regularly. What do

they like about the content and

design of these sites? Why do

some Home pages work and not

others? What could be done to

improve Web page design? How

important are the following Web

page design elements: text that

is easy to read, links to other

pages, pictures, animations,

multimedia sounds and music,

video clips, 3D elements, e-mail

reply forms, and interactivity.

Do these elements make the

Web site more appealing or do

they function as a distraction?

REQUIRED SOFTWARE

◆  MICROSOFT WORD 97

◆  MICROSOFT PUBLISHER 97

OPTIONAL SOFTWARE  

◆  INTERNET EXPLORER 

◆  FRONTPAGE 97

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED

Web page from the  “Web66 International Registry of School Web Sites”
from Internet Explorer (http://web66.coled.umn.edu/schools.html) 

HOW TO BEGIN
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In this activity, you will create

your own World Wide Web site

and “publish” your site to a folder.

Deciding on Ideas for
the Web page
SOFTWARE: Internet Explorer

WHAT TO DO: Think about the dif-

ferent kinds of information you

might like to publish on your

Web site such as:

a) information about a science

project or a social studies unit

just completed; 

b) a class directory highlighting 

the diverse cultural back-

grounds of the students in your

school; 

c) a school-sponsored commu-

nity Web site introducing visi-

tors to local community attrac-

tions, popular restaurants, cool

clothing stores; or, 

d) pictures from a recent class

trip, along with student reports.

Use Internet Explorer to visit

other school Web sites for

design ideas, such as those list-

ed below. Send e-mail messages

to comment on how you

enjoyed the site or to inquire

about Web design techniques.

Recommended Web Sites

◆ The Global Schoolhouse

http://www.gsh.org/fetc/default.

htm

◆ The Illustrated Spanish

Alphabet Page (Ralph Bunche

School, Harlem, New York)

http://ralphbunche.rbs.edu/ 

For an international mega-list of

school sites, visit:

◆ “Web66 International

Registry of School Web Sites”

http://web66.coled.umn.edu/

schools.html 

Creating the 
Web Page
SOFTWARE: Microsoft Publisher 97

WHAT TO DO: Use Publisher 97 to

create single-page or multi-page

Web sites, using the new Web

Site PageWizard, or convert

existing Publisher documents,

such as flyers or newsletters, to 

a web site. 

Start Publisher 97. In the open-

ing screen, click the PageWizard

tab and select Web Site

PageWizard (see Example 1).

Follow the on-screen steps to

create a multipage Web site lay-

out. Save your work.

Adding Text and
Graphics
SOFTWARE: Microsoft Publisher 97

WHAT TO DO: You can type your

web page text directly into the

web layout, or you can choose

Insert Text from the File menu

and insert files created in

Microsoft Word, Microsoft Works

or another word processing pro-

gram. Continue replacing the

placeholder text in your web site

with your own text. Proofread

and spell check your file.

To replace a picture with your

own choice, right click on a pic-

ture, then choose Insert Clip

Art. The Microsoft Clip Gallery

offers lots of fun choices for

your web pages. To insert clip

STEP 1

DESCRIPTION

STEP 2

STEP 3

CREATING YOUR OWN WEB SITE

Example 1: Publisher 97 opening screen showing Web Site PageWizard
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art from a file, right click on a

picture, choose Insert Picture

File. Then locate the file you

wish to insert. 

If you decide to develop a new

Web page, Publisher’s Blank

Page publication list includes a

Web page template with auto-

matic formatting to fit a variety

of  video display monitors. 

Adding Hyperlinks
SOFTWARE: Microsoft Publisher   97

WHAT TO DO: In Publisher 97 you

can add hyperlinks to a docu-

ment already on the Internet, to

another page in your Web site,

to an Internet e-mail address, or

to a file on your hard disk. To

add a hyperlink follow these

steps:

◆  Highlight a word on page 1 of

your Web site;

◆  Choose Hyperlink from the

Insert menu;

◆  In the Hyperlink dialog box

(see example 2), click Another

Page in Your Web Site;

◆  Click Next Page, and then click

the OK button.

You should now add a story

or text that is related to the

hyperlink.

Web Design Tips
SOFTWARE: Microsoft Publisher 97

WHAT TO DO: Keep in mind these

design considerations when

using Publisher 97:

◆  Add new pages to a Web site

document by choosing Page

from the Insert menu.

◆  Publisher 97’s Design Gallery

contains an assortment of

ready-made Web navigation but-

tons for email and other Web

page actions (e.g., Home, Next,

Back) and Web Page Dividers.

After inserting a button on your

Web page, highlight this but-

ton’s text, then right-click on the

text and select Hyperlink from

the pop-up menu. Link the but-

ton to another page in your Web

site or to a specific URL.

◆ If there is a TWAIN-compliant

scanner attached to your com-

puter, you can easily scan in

photographs, drawings, or

other graphic elements, for use

on your Web page. 

To insert an image, click the

Picture Frame tool on the

Publisher 97 toolbar, then create

a frame sized to fit your needs.

Position this frame where you’d

like the picture to appear, then

click Scanner Image/Acquire

Scanned Image (Insert menu) to

bring in the scanned graphic.

Publisher automatically inserts

the “captured” picture in the

predrawn frame.

◆  Consider outfitting the Home

page with a directory listing the

names of all students having

pages at this site. If you scan in

STEP 5

STEP 4

CREATING YOUR OWN WEB SITE

Example 2:
Hyperlink dialog box
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student photos, you can format

this directory to have both an

ImageMap and a student name.

To do so, lay out the informa-

tion in a two-column Table of

Contents (produced with the

Table Frame button). Then add

click-on links to each picture

and name. Now, clicking on

either the student’s picture or

the student’s name will take you

to that student’s Web page.

◆  Add graphics to any Web page

by choosing Publisher Clip Gallery

images. Publisher 97 also features

background patterns and text

color combinations to brighten

the appearance of any Web site.

◆  Make your site so appealing

that visitors will want to return.

Provide links to Web pages like

Mega-Math (http://www. c3.lanl.

gov/megamath/) and The Mad

Scientist Network (http://medin

fo. wustl. edu/~ysp/MSN/).

Publishing the Web
Page (to a folder)
SOFTWARE: Microsoft Publisher 97

WHAT TO DO: Before publishing your

Web site to a folder, check for

errors using Publisher 97’s Design

Checker from the Tools menu.

Then to publish your Web site

to a folder, follow these tips:

◆  Choose Publish Web Site to

Folder from the File menu. 

◆  Click New Folder button and

type a name for your site. 

◆  Choose OK.

Importing into
FrontPage 97
SOFTWARE: Microsoft FrontPage 97

WHAT TO DO: If you are using Microsoft

FrontPage 97 to manage your class

or school web site, you can import

the Publisher folder you just creat-

ed (or any folder of HTML files) into

a new or existing FrontPage web

site. The steps below tell you how

to import into an existing FrontPage

web site (see Example 3 for import-

ing to FrontPage.)

◆  Open your existing FrontPage

web site (or use the Corporate

Presence or Personal Home Page

Wizard to create a new site).

◆  In the FrontPage Explorer view,

choose New from the File menu,

then choose FrontPage Web.

◆  Choose Import Web Wizard;

then click the Add to Current Web

check box.

◆  In the Import Web Wizard dia-

log box, click Browse, then locate

your Publisher created Web site

(unless you specified otherwise,

it should be located in c:/Program

Fi l es /Mi cro s o f tPu b l i s her /

Publish/<your file name>

To learn more about Microsoft

FrontPage, visit    http://www.

microsoft.com/frontpage/       ■

Example 3:
FrontPage 97
Web Wizard

STEP 6

CREATING YOUR OWN WEB SITE

STEP 7
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HIGH SCHOOL

BUYING A DREAM CAR

This practical spreadsheet lesson

offers easy answers to life’s per-

plexing math problems like How

much will my dream car really cost

after financing? Students will calcu-

late the cost of purchasing their

very own Lamborghini sports car

and determine if the ultimate price

tag is really worth the investment.

◆ To expand students’ under-

standing of mathematics 

◆ To show practical applica-

tions of math in everyday life

◆ To provide practice in using a

Microsoft Excel worksheet to solve

practical everyday problems

◆ Knows how to open and set

up a Microsoft® Excel worksheet 

◆ Can access the World Wide Web

using Microsoft® Internet Explorer 

Approximately one week

Ask students to name some

exotic sports cars. If a student

mentions a Lamborghini, have

that student tell what he/she

knows about this luxury car.

Tell students that, although this

elite supercar is no longer pro-

duced, its popularity stemmed

from its reputation as a “menacing

road warrior” that could go from

0-60 miles per hour (mph) in 4.2

seconds! Go on to explain that the

car was engineered to hug the

road at a top speed of 183 mph. 

Then tell students that a previ-

ously owned Lamborghini sells for

$150,000. But thanks to Honest

Ed’s easy finance plan, they can

purchase one of these luxury cars

for a mere $150,000 plus interest.

Review the financial concepts

that students will use to complete

this project such as interest rate,

loan term, and repayment period.

Explain that Microsoft Excel has 

a built-in “Periodic Payment

Function” which calculates the

amount you pay for a loan based

on constant payments and a con-

stant interest rate. The payment

function is written as follows:

PMT(rate, nper, pv) where “rate”

is the interest rate for the loan,

“nper” is the total number of pay-

ments for the loan, and “pv” is the

present value or principal (i.e.,

the total amount that a series of

future payments is worth now).

For this function to work correct-

ly, proper “syntax” (the order in

which the function’s variables are

entered) must be observed.

REQUIRED SOFTWARE

◆  MICROSOFT EXCEL 97

OPTIONAL SOFTWARE

◆ I NTERNET EXPLORER 

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

◆  For some added fun, have students use Internet Explorer to visit

the Lamborghini Home page (http://www.lamborghini.com/) or

the web sites of Porsche (http://www.porsche-usa.com/), Ferrari

(http://www.ferrari.it/), or Corvette (http://www.corvette.net/).

E x t e n s i o n

Microsoft CarPoint Web page from Internet Explorer (www.carpoint.com)
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In this activity, you will create a

worksheet to calculate the actu-

al cost of purchasing a previous-

ly owned Lamborghini sports

car that is selling for $150,000.

You will then pose several “what

if” questions about the pro-

posed purchase terms of this

exotic “dream car” to see how

various terms affect the amount

of interest paid for the car.

Create a Worksheet
SOFTWARE: Microsoft Excel

WHAT TO DO: Create a new

Microsoft Excel worksheet like

the one in Example 1. Follow

these time-saving tips:

◆ Worksheet Titles: To create a

bold face and centered worksheet

title, type the title in column A

and press Enter. Highlight

columns A through E and then

click the Merge and Center but-

ton on Microsoft Excel’s

Formatting toolbar. Click the Bold

button. Increase the font size of

the text to 14.

◆ Word Wrap: Enter cell con-

tents in column A. To turn on

word wrap, highlight all cells in

which text must wrap (A6:A12)

then right-click the highlighted

cells. Click the Alignment tab,

then select Wrap text in the Text

control section.

◆ Column Width: To adjust col-

umn width, double click the col-

umn boundary to the right of a

column heading. To create

columns of uniform width, select

those columns, choose Column

from the Format menu, choose

Width, then enter a value, e.g. 14.

◆ Formatting Currency: Format

cells B4, B6, B10, B11, and B12

as Currency, by selecting B4,

then pressing the Ctrl key while

clicking the other cells. Right-

click on a highlighted cell, then

choose Format Cells from the

pop-up menu. Click the Number

tab and choose Currency with 2

decimal places.  

◆ Saving Work: Turn on

AutoSave to have Microsoft

Excel save a workbook automat-

ically at a time interval that you

specify. If AutoSave is not avail-

able from the Tools menu,

choose Add-Ins from the Tools

menu, place a check mark in the

AutoSave Add-Ins dialog box,

click OK. Then choose AutoSave

from the Tools menu to specify

the time interval for Automatic

Save. Now Microsoft Excel will

pop up save reminders.

Adding Formulas
SOFTWARE: Microsoft Excel

WHAT TO DO: Follow these time-

saving tips for adding formulas:

◆ PMT Function: In Cell B10

paste Microsoft Excel’s PMT

function (Periodic Payment

Function). Click cell B10, then

choose Function from the Insert

menu. Select Financial from the

Function Category list, then

choose PMT from the Function

Name list.  Click OK. 

Type the following cell refer-

ences in the PMT dialog box.

For Rate (the interest rate per

period for the loan), type B7/B9;

for Nper (the total number of

loan payments), type B8*B9; for

Pv (loan amount), type B6.

Choose OK.  Microsoft Excel

returns a negative number to

indicate that you are making a

payment. Note: To work with

positive numbers on the work-

sheet, calculate PMT as follows:

PMT(rate,nper,-pv).

◆ “Total Amount Paid” 

Formula: In B11, type the follow-

ing formula, which will calculate

STEP 1 STEP 2

DESCRIPTION

BUYING A DREAM CAR

Example 1: Microsoft Excel worksheet designed to calculate interest and
total payment for a purchase, based on different loan terms.
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the total amount paid for a loan:

=SUM(B10*(B8*B9)), where

B10=PMT (i.e., the amount paid

each payment period) and

B8*B9 =nper (the total number

of loan payments).

◆ “Interest Paid” Formula: In

B12, type the following formula

which calculates the total

amount of interest paid:

=SUM(B11-B6), which is the

total amount paid minus the

loan amount. 

◆ Showing Formulas: To have

Microsoft Excel show formulas,

rather than formula results,

choose Options from the Tools

menu; click the View tab, then

select the Formulas check box. To

display formula results, clear the

check box.

Once you format the cell con-

tents of column B, entering

appropriate formulas where nec-

essary, you can copy cell content

and format to columns C and D

using Autofill or Fill Right.

Reality Check
SOFTWARE: Microsoft Excel

WHAT TO DO: Once your work-

sheet is set up, you can pose dif-

ferent “what if” questions about

your loan to see how the total

amount of interest paid might

change. For example, what if the

interest rate was 4% and the

length of the loan was ten years?

What would your monthly pay-

ment be? How much interest

would you pay over the life of

the loan? 

Assume you want to pay a

maximum of $250 per month for

a new car. Also, assume that you

are willing to take out a five-year

loan at an interest rate of 5 per-

cent. Calculate the maximum

selling price of a car you can

afford, based on those assump-

tion. Use the same worksheet,

entering numbers in Column E.

First, select E10 (the cell with

the PMT function), then choose

Clear/ Contents from the Edit

menu to delete the formula.

Copy contents of cells D7:D9 to

E7:E9. Copy formulas in D11 and

D12 to E11 and E12 respectively.

Now enter 250 in Cell E10.

(This is the amount of money

you want to pay each month).

On a piece of scratch paper,

solve the following algebraic

equation where  X=price of car

per month and .05X=monthly

cost of interest. For example:

X + .05X = 250 

1.05X = 250

X = 238.1

Each time you pay $250,

$238.10 is principal and $11.90

is interest. You can now deter-

mine the amount you can afford

to pay for the car, assuming no

down payment.

In E6 enter the following for-

mula: =238.1*(E8*E9), where

$238.1 is the monthly principal

and the product of E8*E9 is the

number of total payments.       ■

STEP 3

BUYING A DREAM CAR

Example 2: Microsoft Excel s Periodic Payment Function.
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